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Related Documentation and Services

Manuals
Hummingbird manuals contain conceptual information on your product, procedural information on installing and 
using the product and related applications, and some manuals contain programming reference, interface reference, and 
troubleshooting information. 

All manuals are available in print and PDF. The PDF versions require Adobe Acrobat Reader, and are installed only if 
selected during installation. Your Hummingbird product comes with the following manual(s):        

Help
The Help is a comprehensive, context-sensitive collection of information regarding your Hummingbird product. It 
contains conceptual and reference information, and detailed, step-by-step procedures to assist you in completing your 
tasks. 

Release Notes
The release notes for each product contain descriptions of the new features and details on release-time issues. They are 

available in both print and HTML. The HTML version can be installed when you install the software. Read the release 
notes before installing your product. 

Exceed onDemand Administrator’s 
Guide

Contains information for administrators about installing 
and managing Exceed onDemand.
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Hummingbird Exposé Online

Hummingbird Exposé Online is an electronic mailing list and online newsletter. It was created to facilitate the delivery 

of Hummingbird product-related information. It also provides tips, help, and interaction with Hummingbird users. To 
subscribe/unsubscribe browse to the following web address:

 http://www.hummingbird.com/expose/about.html

User Groups and Mailing Lists
The user group is an unmoderated, electronic mailing list that facilitates discussion of product-related issues to help 
users resolve common problems and to provide tips, help, and contact with other users.

To join a user group:

Send an e-mail to listserv@hummingbird.com, leaving the Subject line blank. In the body of the e-mail message, type the 
following: 

subscribe exceedusers Your Name

To unsubscribe:

Send an e-mail to listserv@hummingbird.com, leaving the Subject line blank. In the body of the e-mail message, type the 
following:

unsubscribe exceedusers Your Name

To post a messages to the user group:

Send your e-mail to:

exceedusers@hummingbird.com

To search the mailing list archives:

Go to the following web site:

http://www.hummingbird.com/support/usergroups.html
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Chapter 1: Installing Exceed onDemand
About Exceed onDemand

Welcome to Exceed onDemand, the Hummingbird ultra-thin connectivity 
solution. This stand-alone product delivers X11R6.6 X access with minimal 
overhead. A small client-side installation lets you access business-critical 
X applications on UNIX, Linux, VMS, and other X Window System hosts.

Typically, X clients communicate with X Display Servers to display the 
output and receive input. In the case of Exceed onDemand, X clients 
communicate with Exceed onDemand Proxy via the X protocol. In turn, 
Exceed onDemand Proxy communicates with Exceed onDemand Client via 
the Thin X Protocol (TXP). 

Exceed onDemand offers a number of startup modes, which enable two 
types of connectivity: direct client-server connectivity,

UNIX/Windows Host

 applications
Exceed onDemand Server

PC PC PC

Exceed onDemand Clients
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 and gateway server connectivity.

A number of features ensure secure, consistent, and dependable 
X connections:

• Exceed onDemand authenticates user names and passwords for all host 
connections.

• Secure Sockets Layer (SSL) options ensure secure communication 
between Exceed onDemand Server and Exceed onDemand Client or 
Server Manager.

• An optional SSH startup mode extends security by encrypting user 
credentials and X11 traffic.

• Centralized management results in a uniform end-user experience.

UNIX/Windows

Exceed onDemand Server

PC PC PC

Exceed onDemand Clients

UNIX HostUNIX HostUNIX Host

  applications   applications  applications
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Overview of Installation

Installing Exceed onDemand is a three-part procedure:

For more information on 
supported platforms, see 
“System Requirements” on 
page 7.

1 Install Exceed onDemand Server on a UNIX or Windows platform. If 
you install Server on Windows, you can select and install other Exceed 
onDemand Server components.

2 Install the following Exceed onDemand Server components as required 
on other network machines.

• Exceed onDemand Server Manager

• Exceed onDemand Deployment Tools 

• Exceed onDemand Print Utility (elpr)

• Exceed onDemand Keyboard Editor (XKeys)

For more information, see “About Server Components” on page 17.

3 Make Exceed onDemand Client available to users. To do this, you have 
the option of using the Deployment Tools mentioned in step 2 above.

Preserving Files When Upgrading
Exceed onDemand 4.5 is backward compatible with version 4.0. When you 
install Exceed onDemand 4.5 on a machine where an earlier version was 
installed, both the Hummingbird Setup Wizard and the UNIX installer 
preserve some directories and files to avoid the need to reconfigure the 
product and to maintain existing profiles.

Exceed onDemand Server
The Exceed onDemand Server installation (Windows and UNIX) preserves 
the following when you upgrade from version 4.0 to 4.5:

• Global Xinitrc configuration file 

• new-user (default) account settings

• global and user-specific configuration profiles

• user-specific account settings

• SSL keys

• any manually added fonts (not originally installed with version 4.0)
5
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Exceed onDemand Server Manager
Hummingbird Setup preserves your SOCKS configuration. The file is saved 
in the version 4.5 default location.

Exceed onDemand Client
Exceed onDemand Client version 4.5 is backwards compatible with version 
4.0. When you install the new version, Hummingbird Setup migrates any 
connection documents (.eod files) saved in the default location, and then 
uninstalls version 4.0. The SOCKS configuration file is also preserved.

If you upgrade from Exceed onDemand Client version 3.2 to 4.5, 
Hummingbird Setup does not uninstall the older version. Instead, it copies 
the connection documents and SOCKS configuration file saved with 
version 3.2 to the version 4.5 default location, and both versions of the 
client co-exist on your machine.

Registering
You can register this product by:

• running Msetup.exe from the product CD, then clicking Register Online

• completing and registering the form at the following URL:

http://www.hummingbird.com/register/

• completing the registration card provided in the product package and 
mailing it to Hummingbird Ltd.

After registering, you and your organization are recognized as a licensed 
product owner with all rights and privileges. This makes you eligible to 
receive a wide range of customer services, such as a free subscription to our 
quarterly newsletter, Hummingbird Exposé Online, as well as notification of 
software upgrades and new products. If you and your organization move to 
a new location, complete and mail the change of address card included in 
the product package. This ensures you will continue receiving update 
notices and other important information.
6
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Chapter 1: Installing Exceed onDemand
System Requirements

Exceed onDemand Server 
A host with 256 MB RAM and 140 MB of disk space is recommended. 
Exceed onDemand Server supports the following platforms:

• Sun (SPARC) Solaris 2.51, 2.6, 2.7, 2.8, 2.9

• Solaris Intel 2.8

• HP-UX 10.20, 11.0

• IBM AIX 4.2, 4.3, 5.2

• Linux kernel level 2.4 or greater

• Windows:

• NT 4.0 Server (Service Pack 6a or greater)

• NT 4.0 Workstation (Service Pack 6a or greater)

• 2000 Server

• 2000 Advanced Server

• 2000 Professional

• Server 2003

• XP Professional

Exceed onDemand Client and Components
A Pentium or higher with 64 MB RAM is recommended. Exceed 
onDemand Client, Server Manager, and Deployment Tools support the 
following Windows platforms:

• NT 4.0 Server

• NT 4.0 Workstation

• 2000 Server

• 2000 Advanced Server

• 2000 Professional

• Server 2003

• XP Professional

• 98

• Me
7



Exceed onDemand Administrator’s Guide
Installing Exceed onDemand Server on a UNIX Platform

You must have root or superuser access on the machine on which you want 
to install Exceed onDemand Server. Make sure you have sufficient disk space.

To install Exceed onDemand Server:

1 Log in as root user:

$su root

passwd: Password

2 Go to the Exceed_onDemand/Server directory on the CD. From the 
folder that coincides with your operating system, copy the self-
extracting executable to a local directory. These files are named 
according to platform and operating system.

3 Run the executable from its new location.

4 Specify a location to which the installer should extract the files, or 
accept the default location, which is the current directory.

5 Once all necessary files are extracted, the license agreement appears. 
Read the agreement and type y to accept the terms.

Note: Exceed onDemand Print Utility (elpr) is part of the Exceed 
onDemand Server for UNIX installation. However, you may have to 
install it independently on other machines. For more information, 
see, “Installing Exceed onDemand Print Utility” on page 18.

Note: Failure to read the license agreement does not affect the 
terms and conditions of the agreement.
8
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6 When prompted, provide the following information:

• Server Port—Specify the port number on which the Server listens. 
Press Enter to select the default port: 5500.

• Proxy Port—Specify the number of the port through which the 
proxy transfers X session data. The default is 5501. This port number 
must be different from the server port number. Unlike the server 
port, changing this port from the default has no effect on users.

• Starting Display ID—Specify the display number for the first Exceed 
onDemand Client session. All subsequent displays are numbered 
accordingly. Press Enter to select the default first display: 1.

7 On the confirmation screen, type y to confirm the settings.

8 If you installed version 4.0 prior to this installation, indicate whether 
you want to copy settings from that installation.

9 Specify an installation directory. If a default location is provided, 
indicate whether you want to use it.

10 If a GlobalXinitrc file does not exist from a previous installation, one is 
generated. Press Enter to continue.

11 The Activation Key utility opens. Select one of the five options by typing 
the number and pressing Enter. When you have performed all the 
required tasks, select option 4 to save the changes and exit the utility.

Note: If you change the default port number, you must provide your 
users with the new number to enable them to connect to the server. 
9
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12 If version 4.0 was not installed prior to this installation, you must enter 
the account name for the first Exceed onDemand administrator. The 
administrator you designate can then add other accounts to the 
administrative group. Press Enter to select the default option of root.

The installer generates an installation log file and displays its location. 
You can refer to this file to ensure that the installation was successful.

13 When prompted to start Exceed onDemand Server, type y. The Server is 
now installed and started.

Uninstalling Exceed onDemand Server on UNIX

To uninstall Exceed onDemand Server:

1 Stop the server by running the ttxpmstop utility.

2 Delete the Exceed onDemand Server installation directory from the 
UNIX host.

Installing Exceed onDemand Server and Other Components 
on Windows

Before installing Exceed onDemand Server, you must log on with 
Administrator authority, and ensure that you have write access to the 
Windows system directory and registry. This is not the case for other Server 
components.

Note: Superuser accounts are not added to the Exceed 
onDemand administrative group automatically.
10
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By default, Exceed onDemand Server includes the following components in 
addition to Exceed onDemand Server itself:

• Exceed onDemand Server Manager

• Exceed onDemand Deployment Tools

• Exceed onDemand Print Utility (elpr)

• Exceed onDemand Keyboard Editor (XKeys)

• Hummingbird Update

You can modify the installation and install any component independently 
on other network machines where necessary. For more information, see 
“About Server Components” on page 17.

To install Exceed onDemand Server on a Windows platform:

1 When you insert the CD into the drive, autorun launches the 
Hummingbird Master Setup application. If Master Setup does not launch 
automatically, run Msetup.exe from the root directory of the CD.

2 In the Hummingbird Master Setup application window, click Install 
Exceed onDemand Server Components.

3 In the next window, select the installation type. Hold the mouse pointer 
over the installation type to view a brief description of it.

Exceed onDemand Setup prepares Setup Wizard, checks the operating 
system, and checks the current Windows Installer version.

• If necessary, the version is updated and the Setup Wizard continues.

• If Windows Installer is not present on your operating system, or if 
the existing version is not 2.0, Setup Wizard installs the latest 
version of the service.

4 After configuring Windows Installer and preparing to install, Setup 
Wizard proceeds to the Welcome dialog box. Click Next.  

Note: To quit installation, click Cancel in any Setup Wizard dialog 
box. Your computer is not affected if you do this before the Setup 
Wizard copies files. To review or change settings in a previous 
dialog, click Back.
11
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The Next button is 
unavailable if the terms of 
the license agreement are 
not accepted.

5 Read the license agreement. If you accept the terms, click Next.   

6 The Customer Information dialog box opens. Type the required 
information and indicate who may access this installation of Exceed 
onDemand Server. Click Next.

7 The Custom Setup dialog box opens. Select the features you want to 
install and click Next. You can view more information about features 
and perform the following customization:

• Expand a feature category by clicking the plus icon  to view a tree 
of features or sub-features. Similarly, click the minus icon  to 
collapse the feature tree.

• Click a feature icon to display a pop-up menu of icons and install 
options. Click a pop-up menu icon. The icon in the feature tree 
changes according to your selection. Click Help to view a dialog box 
with tips.

• Click Change to open the Change Current Destination Folder dialog 
box and install the feature to a folder other than the default. 

• Click Space to open a dialog box listing all local drives (logical 
partitions) and mapped drives on the machine. The dialog box 
provides detailed information about available disk space.

Note: Failure to read the license agreement does not affect the 
terms and conditions of the agreement.

Note: If you did not select the Exceed onDemand Server feature 
(component), proceed to step 10.
12
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8 In the Server Settings dialog box, specify the following, and click Next.

• Starting Display ID—Specifies the display number for the first 
Exceed onDemand Client session. All subsequent displays are 
numbered accordingly. 

• Server Port—This is the port number on which the Server listens. 
Press Enter to select the default port: 5500.

• Proxy Port—Specify the number of the port through which the 
proxy transfers X session data. This port number must be different 
from the server port number. The default is 5501. Unlike the server 
port, changing this port from the default has no effect on users.

9 The Exceed onDemand Server Administrator Settings dialog box opens. 
Enter the activation key, and then enter the account name of the first 
Exceed onDemand administrator. You are allotted 10 attempts to enter 
the correct activation key before Setup closes.

10 The Ready to Install the Program dialog box opens. Click Install to 
continue.

11 When the installation is complete, click Finish. You may be prompted to 
restart your computer.

Note: If you change the default port number (5500), you must 
provide your users with the new number to enable them to 
connect to the server. 

Note: For information on uninstalling Exceed onDemand Server 
for Windows, see “Program Maintenance” on page 14.
13
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Program Maintenance
Program maintenance lets you modify, repair, or uninstall existing 
Hummingbird products and components installed on a Windows platform. 
You can access Program Maintenance from either the product CD or by 
clicking Add/Remove Programs in Control Panel.

To modify the install state of program features and components:

1 Open Program Maintenance by running Msetup.exe from the product 
CD. Alternatively, double-click Add/Remove Programs in Control Panel, 
select the Hummingbird program in the Add/Remove Programs dialog 
box, and click Change. The Setup Wizard Welcome dialog box opens.

2 Click Next. The Program Maintenance dialog box opens.

3 In the Program Maintenance dialog box, select Modify and click Next. The 
Custom Setup dialog box opens.

4 Expand the feature tree and change the install state, as necessary, and 
then click Next. 

• Expand a feature category by clicking the plus icon  to view a tree 
of features or sub-features. Similarly, click the minus icon  to 
collapse the feature tree.

• Click a feature icon to display a pop-up menu of icons and install 
options. Click a pop-up menu icon. The icon in the feature tree 
changes according to your selection. Click Help to view a dialog box 
with tips.

5 In the next dialog box, click Install and the install state of program 
features changes according to your specifications.

6 Installation (modification) proceeds to completion. Click Finish to exit.

To repair a program:

1 Open Program Maintenance by running Msetup.exe from the product 
CD. Alternatively, double-click Add/Remove Programs in Control Panel, 
select the Hummingbird program in the Add/Remove Programs dialog 
box, and click Change. The Setup Wizard Welcome dialog box opens.

2 Click Next. The Program Maintenance dialog box opens.
14
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3 In the Program Maintenance dialog box, select Repair and click Next.

4 The Ready to Repair the Program dialog box indicates Setup Wizard is 
ready. Click Install to repair errors such as missing or corrupt files, 
shortcuts, and registry entries.

5 Program repair proceeds to completion. Click Finish to exit.

To remove a program:

1 Open Program Maintenance by running Msetup.exe from the product 
CD. Alternatively, double-click Add/Remove Programs in Control Panel, 
select the Hummingbird program in the Add/Remove Programs dialog 
box, and click Change. The Setup Wizard Welcome dialog box opens.

2 Click Next. The Program Maintenance dialog box opens.

3 Select Remove and click Next.

4 The Remove the Program dialog box indicates Setup Wizard is ready. 
Click Remove to uninstall the program.

5 Program removal proceeds to completion. Click Finish to exit.

Silent Installation
A silent installation runs in the background. You can perform silent 
installations for Exceed onDemand Server and Exceed onDemand Client. 

To run a silent installation:

1 Launch Setup Wizard from the command line using the syntax for the 
specific Exceed onDemand component you want to install:

• Server:

E:\Exceed_onDemand\Server\Win32\Setup.exe /S /V”/qn 
EOD_SERIALNUM=activationkey”

• Client:

E:\Exceed_onDemand\Client\EoD-4.5-Client.exe /S 

Note: To install Exceed onDemand Server, you must log into the 
PC as the (local) administrator.
15
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where E:\ is the CD-ROM drive. The following describes the silent 
installation options: 

2 Installation proceeds to completion.

Updating the Product
Hummingbird Update lets you check for Exceed onDemand Server updates 
issued by Hummingbird Ltd. The connection settings for Hummingbird 
Update are preconfigured. If necessary, you can edit the connection settings 
from the Settings page after you open the WebUpdate dialog box as described 
in the following procedure.

To update the product:

1 From the Windows Start menu, run Hummingbird Update. It is located 
in Administrative Tools in the Hummingbird Exceed onDemand 4.5 
program group. The WebUpdate dialog box opens.

2 Select Hummingbird Exceed onDemand Server 4.5 and then click Check 
For Updates. If an update is available, you are prompted to install it. 
Click Yes.

The update downloads and Setup Wizard prepares the setup process.

3 You are informed when Setup Wizard is ready. Click Next.

4 Installation proceeds to completion.

Option Description

/S Specifies a silent installation.

/V/qn /V passes parameters to Msiexec.exe.

Note: There are no spaces between the /V and 
/qn options and that V is upper-case. If a character 
string contains a space, put quotes around it. For 
example: /V”parameter space”

EOD_SERIALNUM Specifies the activation key, located on the product 
CD package.
16
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About Server Components

After you install Exceed onDemand Server (on UNIX or Windows), you 
have the option of installing the server components elsewhere on the 
network as required to suit your needs. 

You can install the following components:

Exceed onDemand Server Manager     Server Manager lets you remotely 
manage any Exceed onDemand Server (UNIX or Windows) on the 
network. You can install this tool on any network PC running a supported 
Windows platform.

Exceed onDemand Deployment Tools     These three tools let you generate, 
distribute, and maintain web-deployable installations of Exceed onDemand 
Client, so that your users can install the client from the Web. Install this tool 
set on any PC running a supported Windows platform, but you must also 
install Exceed onDemand Client. 

Exceed onDemand Print Utility (elpr)     This utility lets users print from 
the X applications they run with Exceed onDemand. You must install the 
printing utility on each machine running X applications from which users 
need to print. The utility is installed with Exceed onDemand Server. 
However, in cases where users will use Exceed onDemand Server to connect 
to and print from X applications that are running on other machines, you 
must install the print utility on each of the peripheral machines as well. This 
component is available for UNIX and Windows.

Exceed onDemand Keyboard Editor (XKeys)     XKeys is a keyboard editor 
that simplifies the job of creating customized keyboard definition files. To 
distribute the custom files you create, you can add them to global or user-
specific configuration profiles. Install this tool on any PC running a 
supported Windows platform.

Note: A readme for the print utility is located in the 
\Utilities\elpr directory on the CD.
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Installing the Components on Windows
To install an Exceed onDemand component on a supported Windows 
platform, follow the procedure for installing Exceed onDemand Server for 
Windows. When Hummingbird Setup Wizard presents the Custom Setup 
dialog box, select only the component(s) you want to install.

For an alternative method of installing Exceed onDemand Print Utility, or 
to install the utility on a UNIX platform, see below.

Installing Exceed onDemand Print Utility
Exceed onDemand Print Utility (elpr) is installed automatically with Exceed 
onDemand Server for UNIX, and is an optional installation when you 
install Server for Windows.

A stand-alone version is also available on the product CD. You must install 
the stand-alone version on any machine (other than the Exceed onDemand 
Server machine) that runs X applications from which your users need to 
print. 

To copy Exceed onDemand Print Utility from the CD:

1 In the /Exceed_onDemand/Utilities/elpr directory, open the folder 
that coincides with the operating system of the machine on which 
you want to install the Print Utility. 

2 Copy the elpr file to a local directory. Ensure that the directory is 
accessible to Exceed onDemand Client users.

Note: For an alternative method for installing Exceed onDemand 
Print Utility on Windows, see “Installing the Components on 
Windows” on page 18.
18



Chapter 1: Installing Exceed onDemand
Uninstalling Components

If you installed components using Hummingbird Setup Wizard:

Select Exceed onDemand Server in the Windows Add/Remove Programs 
dialog box, and then click Remove. If Exceed onDemand Server is installed 
on the same machine, and you do not want to uninstall it along with the 
components, click Change instead of Remove. For more information on 
changing or removing an installation, see “Program Maintenance” on 
page 14.

If you copied Exceed onDemand Print Utility from the CD:

Delete the elpr file from the installation location.

Installing Exceed onDemand Client

The Exceed onDemand system administrator makes the Client installation 
available to users. Because the installation is small, you may opt to 
distribute the file over the network, or by e-mail or browser download. An 
end user can install Client as long as that user has write permission for the 
destination folder.

To install Exceed onDemand Client:

1 Insert the product CD into your CD ROM. 

2 In the Master Setup window, click Install Exceed onDemand Client, and 
then click Install Exceed onDemand Client.

Note: 

• You can use Exceed onDemand Deployment Wizard to create 
an installation package to deploy Exceed onDemand Client 
over the web. For more information, install the Deployment 
Tools and refer to the Help.

• You can also perform a silent installation. For more information, 
see “Silent Installation” on page 15.
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3 In the Welcome window, click Next.

4 Read the license agreement. Click Yes to accept the terms.

5 In the Destination Folder dialog box, confirm the folder destination. To 
install in a different directory, click Browse and select another directory. 
If you want an Exceed onDemand Client shortcut to appear on the 
Desktop, click the appropriate check box. Then click Next.

6 Select the languages you want to include. To select the default language, 
double-click that language. Then click Next. The Ready to Install dialog 
box appears. 

7 Click Install to begin the installation.

8 After Setup completes all operations, click Finish. When the installation 
is finished, an Exceed onDemand Client shortcut appears in the 
Hummingbird Exceed onDemand 4.5 program group on the Star t menu, 
and, if you opted to create a shortcut on the Desktop, a shortcut appears 
there too.

Uninstalling Exceed onDemand Client
To uninstall Exceed onDemand Client, you must remove the following two 
application using the Add/Remove Programs feature in Windows Control 
Panel:

• Hummingbird Exceed onDemand Client

• Hummingbird Component Deployment

After uninstalling the Hummingbird Component Deployment, you must 
reboot the PC.

Note: Failure to read the license agreement does not affect the 
terms and conditions of the agreement.
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About Exceed onDemand Deployment Tools

Hummingbird Exceed onDemand Deployment Tools consists of the 
following components:

Exceed onDemand Deployment Wizard     You can use the Deployment 
Wizard to create a web-deployable installation of Exceed onDemand Client 
for your end users. 

Exceed onDemand Index Page Wizard     The Index Page Wizard lets you 
create a single web page that contains links to multiple deployment packages.

Exceed onDemand Package Update Wizard      Exceed onDemand Package 
Update Wizard simplifies the task of updating the Exceed onDemand Client 
version within existing deployment packages.

About Exceed onDemand Deployment Wizard

Exceed onDemand Deployment Wizard simplifies the task of Exceed 
onDemand administration. With it, you can do the following:

• Distribute Exceed onDemand Client to both in-house and remote end 
users over the Web.

• Update your users’ Exceed onDemand Client software automatically by 
deploying the latest version from the web server. 

• Control feature availability to provide users with a uniform work 
experience.

• Preconfigure Exceed onDemand Client sessions that are launched from 
the web page to ensure optimal performance. For example, you can 
automate the connection to the host so that when users launch a session 
from the web page, they are logged into a specific host using the 
connection parameters and configuration profile you specify.
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Overview of the Deployment Process
The following is a summary of key steps in the deployment of Exceed 
onDemand Client over the web. 

To deploy Exceed onDemand Client:

1 Use Exceed onDemand Deployment Wizard to generate an HTML page 
and a deployment package. 

2 If you did not generate the files directly on the web server, move the 
generated files to the server. 

3 The package, a collection of compressed files, is accessed by end users 
through the URL you provide them.

4 The content of the package is extracted and installed on users’ machines 
and used to launch Exceed onDemand Client sessions. 

Creating a Deployment Package
To deploy Exceed onDemand Client over the web, create a deployment 
package by configuring the settings in the Deployment Wizard window. 
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To create a deployment package:

1 To create a new deployment package, using the Deployment Wizard 
default settings, click New on the File menu.

For more information, see 
“Configuring Deployment 
Wizard Settings” on 
page 25.

2 Configure the Deployment Wizard settings. 

3 When you have configured all the required settings and want to 
generate the deployment package, click Create on the File menu. 
Deployment Packager generates the package and saves the package 
settings as a project.

To open a deployment project:

1 To open an existing project, click Open on the File menu. The Exceed 
onDemand Deployment Projects dialog box opens. 

2 Select a project and click Select to open it. The Deployment Wizard 
displays the package settings specified in the selected project. 

Configuring Deployment Wizard Settings 

The Deployment Wizard is divided into three settings areas, each 
responsible for a different stage of deployment.

General Area
For more information, see 
the Exceed onDemand 
Deployment Help.

These settings let you specify the project name, and the HTML file name 
and page title. You must also specify a destination path for the deployment 
package. If you do not specify a web server directory as the destination, you 
must move the package there after it is generated.

Note: You can also use the Deployment Projects dialog box to 
delete a selected project by clicking Delete. The project and 
associated package files are deleted from the default EoD 
Packages and EoD Projects folders.
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Launch Parameters Area
These settings let you specify the parameters for launching an Exceed 
onDemand session. What occurs after users click the deployment link on the 
HTML page depends on how much information you provide in this area:

• If you provide all of the information necessary to start a session, the 
session will be launched automatically as per the parameters you specify. 

• If you provide some or none of the information, Exceed onDemand 
Client will prompt the user for any missing information before starting 
the session.

Deployment Settings Area
These settings let you configure options for the web-deployed Client. You 
must also specify the location on the users’ machines where you want 
Exceed onDemand Client to be installed.

Exceed onDemand Directory Variables
Exceed onDemand Deployment Wizard directory variables are similar to 
Windows environment variables except they are supported in the same way 
on all platforms. The directory variables are also prefixed and suffixed with 
$ instead of %.

The following variables are supported:

Variable Description

$PROGRAMFILES$ This variable will resolve to the full path of the Program Files directory on 
the target machine.

$APPDIR$ This variable will resolve to the application directory as specified in the 
Installation area of the Deployment Settings.

$SYSDIR$ This variable will resolve to the full path of the Windows System directory. For 
example: c:\windows\system32 on Windows XP, c:\windows\system on 
Win98.
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Making the Package Available
The following procedure is best suited to cases where you want to make only 
one deployment package available to all your users. If you create more than 
one deployment package (for different groups or users), consider using 
Exceed onDemand Index Page Wizard to simplify the task of distribution. 
For more information, see “About Exceed onDemand Index Page Wizard” 
on page 28.

To make a package available:

When you generate a deployment package, Exceed onDemand Deployment 
Wizard creates a projectname folder with the name you specified in the 
Project Name box. To locate this folder, refer to the Location box within the 
General settings area of the wizard.

The projectname folder contains the following:

• a Package folder

• an HTML file (with the name you specified in the HTML File Name box)

Place both of these items on the web server and provide users with the URL 
to access the HTML file.

$WINDRIVE$ This variable will resolve to the drive that Windows is installed to on the target 
machine. For example c:, d: (note, trailing backslash is removed).

$USERWINAPPDATA$ This variable will resolve to the full path of the user’s Application Data 
directory on the target machine. For example, on Windows XP: 
c:\documents and settings\username\application data

$ALLUSERWINAPPDATA$ This variable will resolve to the full path of the All Users Application Data 
directory on the target machine. For example, on Windows XP: 
c:\documents and settings\all users\application data

$DESKTOP$ This variable will resolve to the full path of the currently-logged in user’s 
desktop directory on the target machine. For example, on Windows NT: 
c:\winnt\profiles\user\desktop and on Windows XP, c:\documents 
and settings\user\desktop

Variable Description
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About Exceed onDemand Index Page Wizard

Exceed onDemand Index Page Wizard lets you generate an HTML web page 
that contains links to multiple deployment packages created in the 
Exceed onDemand Deployment Wizard. The Index Page Wizard lets you 
specify multiple existing deployment packages, and then generates a single 
HTML page that contains multiple links, one for each package. You can 
then move the index page (with all of the packages to which the index page 
points) to a web server and distribute the URL to users.

For example, if you use the Deployment Wizard to create deployment 
packages for each department in your company, and then use the Index Page 
Wizard to create an index page that contains links to all of the deployment 
packages you created, you can then distribute one index page URL to all 
departments. Users from each department can open a deployed package on 
their machine by selecting the appropriate link on the index page. 

Creating an Index Page
Before you create an index page, you must first use the Deployment Wizard 
to create all the projects to which the index page will point.
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To create an Index Page:

1 In the Index Page File Name box, specify a name for the wizard-generated 
.html file.

2 In the Index Page Title box, specify a title for the HTML page. The title 
appears at the top of the index page and in the title bar of the browser 
window containing the HTML page. 

3 If you want to include a banner or background image for the HTML 
page, specify an image file in each of the appropriate boxes.

4 Select the deployment package(s) to include on the index page. Select 
the check box beside each package you want to include in the index, or 
click Select All or Clear All on the Edit menu. 

5 Click Generate on the File menu. The Index Page Wizard saves the index 
page as an .html file in the EoD Packages folder.

6 Copy the .html file, as well as the deployment package folders to which 
the index page points, to a web server directory. If you included a 
banner or background image, you must also copy the Images folder.

7 Distribute the URL for the index page to end users. The user can open 
the deployed package on the client machine by selecting the appropriate 
link on the index page.

Note: If you specify a .bmp file for the background image, it will not 
appear if the user is using Netscape 4.x. to view the index page.
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About Exceed onDemand Package Update Wizard

With Exceed onDemand Package Update Wizard, you can update the 
Exceed onDemand Client version within selected deployment packages 
without having to manually apply changes to each individual package.

Updating Exceed onDemand Client for Deployment
Exceed onDemand Package Update Wizard simplifies the task of updating 
the Exceed onDemand Client version within existing deployment packages. 
You can use the Package Update Wizard to select deployment packages that 
you want to upgrade. 

To update existing deployment packages:

1 Install the updated version of Exceed onDemand Client.

2 Launch the Package Update Wizard. In the list of existing deployment 
packages (previously created with Exceed onDemand Deployment 
Wizard), select the check box beside each project name that you want to 
update, or click Select All or Clear All on the Edit menu.

3 Click Update on the File menu.

4 Copy the updated packages to the web server.
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About Exceed onDemand Administration

The task of managing Exceed onDemand includes:

• configuring Exceed onDemand Server by specifying port numbers, or 
enabling/disabling security features

• configuring user account settings that permit or restrict Exceed 
onDemand users access to specific functionality

• tracking session information such as which users are currently running 
client sessions, or how many sessions are currently suspended

• creating and distributing configuration profiles to users

• managing licenses

• troubleshooting 

In this chapter, you will find information on performing Exceed onDemand 
Server management tasks for both Windows and UNIX installations of 
Exceed onDemand Server.

About Exceed onDemand Server Manager 

Exceed onDemand Server Manager is a management tool for Exceed 
onDemand administrators. You can install it on any network PC, and use it 
to remotely manage any Exceed onDemand Server (UNIX or Windows) 
installed on the network.
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With Exceed onDemand Server Manager, you can configure server settings, 
manage licenses, and view information about Exceed onDemand Client 
sessions currently running or suspended on a particular Exceed onDemand 
Server. You can also use Server Manager to access Exceed onDemand Server 
Configuration Manager, which lets you configure user account settings, and 
create configuration profiles and manage their distribution.  

The Server Manager window displays information about users and about 
client sessions. The server status information displayed in the title bar is 
refreshed automatically. To update all other displayed information, click 
Refresh on the Actions menu.

You can show/hide 
columns in both view areas 
by right-clicking a column 
heading.

If you want to print information displayed in the Server Manager window, 
you can save the information and print it from the saved file. To save, click 
Save As on the File menu. In the Save As dialog box, specify a location, type 
a file name, and specify a file type. You can save the file in Comma 
Separated Values (*.csv) or HTML (*.html) format. Click Save.
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Connecting to the Server
After you install Exceed onDemand Server Manager, you can launch it from 
the Windows Start menu. When you do, the Connect To Exceed onDemand 
Server dialog box opens, which lets you connect to the Exceed onDemand 
Server you want to manage. You can also access this dialog box by clicking 
Connect on the Server Manager Actions menu.

If you experience problems logging into an Exceed onDemand Server 
installed on Windows XP or Windows Server 2003, see “Troubleshooting 
Connections to Exceed onDemand Server” on page 36.

To connect to an Exceed onDemand server:

1 In the Connect to Exceed onDemand Server dialog box, provide the 
following information:

• Host—Type, or select from the drop-down list, the name of the 
Exceed onDemand Server you want to manage. If that server has 
been configured to use a server port number other than the default 
(5500), you must type a colon and the customized port number 
after the host name:

hostname:portnumber

• User ID—Type your user ID for the specified server. When 
connecting to Exceed onDemand Server installed on Windows, 
provide the domain name and your user name as follows:

domain\username

• Password—Type your password.

2 If SSL is enabled for Exceed onDemand sessions, then you must select 
the Use SSL option in the Connection area. For information on SSL 
settings, see “Configuring Server Settings” on page 37.

3 Click OK.

To end the Server Manager session, click Disconnect on the Actions menu.
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Troubleshooting Connections to Exceed onDemand Server

There are two common reasons for encountering a failure while attempting 

to establish a connection to the server: 

• an SSL setting conflict

• an operating system setting that limits the use of blank passwords

SSL Setting Conflict
If SSL is enabled on the server, you must select the Use SSL option in the 
login dialog box in order to connect successfully. If this does not alleviate 
the problem, then the problem may be related to the server operating 
system settings.

Server Platform Limitation
If the Exceed onDemand Server you want to log into is installed on 
Windows XP or Windows Server 2003, you cannot start a client or 
administrative session if you are using a local account with no password. 
This is a result of a Windows XP/Server 2003 feature that limits the use of 
blank passwords on local accounts to console logon only.

To remove this limitation:

1 In Control Panel, select Switch to Classic View, if necessary.

2 In Administrative Tools, open Local Security Policy.

3 Expand Local Policies and select Security Options.

4 Disable the following option—Accounts: Limit Local Account Use Of 
Blank Passwords To Console Logon Only.
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Configuring Server Settings
You can access the Exceed onDemand Server options by clicking Server 
Settings on the Server Manager Settings menu.        

In the Exceed onDemand Server Settings dialog box, you can configure the 
following options.

General Area

Starting Display ID     Specify the number at which Exceed onDemand 
begins incrementing server displays for clients. You can specify a starting 
display ID from 1 to 9999 inclusive. The default is 1. Use this option to 
avoid occupied server display ports.

Allow Clients to Suspend Sessions     Enable this option if you want to let 
clients suspend sessions on the server and resume them later. 

Note: Option changes require a server restart to take effect. To 
restart the server, click Restart on the Server Manager Actions 
menu. Restarting the server ends the current Server Manager 
Session. A server restart also ends all client sessions. 
Administrators and Client users must reconnect.

Note: Suspended sessions occupy resources on the server. If a 
large number of sessions are suspended, server performance can 
be affected.
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SSH Command     For Exceed onDemand Client users to make use of the 
SSH startup mode, you must make the SSH client available for their 
sessions. Use this area to specify the location of the SSH client executable on 
the server. 

Server Log Area 
Enable this option if you want the server to generate a log file. You can also 
specify a file format by selecting either HTML or Text. To view the log, click 
View Server Log on the Tools menu.

Ports Area
Exceed onDemand Server makes use of two ports to mediate the 
communication between Exceed onDemand Clients and hosts.

Server     Specify the number of the port on which the server listens for 
startup and configuration data (Configuration connection). You can specify 
a port number from 1024 to 5999. The default is 5500. 

Proxy     Specify the number of the port through which the proxy transfers 
X session data. You can specify any number from 1024 to 5999, excluding 
the number of the Server port. The default is 5501. Changing this port from 
the default has no effect on users.

Note: If you change the default port number, you must notify your 
users. When connecting to the host, users will have to specify the 
new port number in the Host box as follows:

HostName:PortNumber
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SSL Area
If you installed either the Strong or the Weak SSL version of Exceed 
onDemand Server, you can configure these SSL options. For more detailed 
information on configuring Exceed onDemand Secure Sockets Layer 
options, see “Configuring Secure Sockets Layer (SSL) Options” on page 49.

For more information on 
Configuration and X 
Session connections, see 
“Configuring Secure 
Sockets Layer (SSL) 
Options” on page 49.

• Enable—This option applies to all Configuration connections between 
the client and the server port. 

• Allow Clients to Disable SSL for Proxy—This option applies to all X 
Session connections between Exceed onDemand Client and the proxy 
port. 

If you enable SSL, the server log lists the available ciphers.

Managing User Accounts
The user account settings let you configure user accounts and control user 
access to certain functionality. To manage user accounts, you can configure 
settings on a default as well as a per-user basis.   

Default accounts are created for users the first time they log onto Exceed 
onDemand. All new users receive the default settings you specify in the New 
User Settings dialog box. 

You then have the option of customizing the settings on a per-user basis 
using Exceed onDemand Server Configuration Manager. For more 
information, see the following procedures.

Note: Administrators cannot edit their own account settings.
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To configure the default account settings for new users:

1 On the Settings menu of the Exceed onDemand Server Manager window, 
click New User Settings.

2 In the New User Settings dialog box, you can enable or disable the 
following settings:

• Account Active—Enable this option if you want new user accounts 
to be active. If you disable this option, accounts are created for new 
users, but they are not active. In this case, first-time users cannot 
start an Exceed onDemand Session until you activate their accounts 
on a per-user basis using the Exceed onDemand Server 
Configuration Manager. For more information, see the next 
procedure.

• Allow Share Sessions—Enable this option if you want to let new 
users share their sessions with other users.

• Allow Edit Profile Options—Enable this option if you want to let 
new users create user-defined profiles and edit them with the 
client-side Exceed onDemand Configuration Manager. For more 
information, see “Distributing Global Profiles to Users” on page 47.

• Allow Suspend Sessions—Enable this option to let new users 
suspend their X sessions. For more information on 
Suspend/Resume functionality, see “Suspending and Resuming 
Sessions” on page 70.

• Allow Resume Sessions From Anywhere—Enable this option to let 
new users resume suspended sessions from machines other than the 
one on which the session was suspended. 

• Maximum Number of Sessions—Specify the maximum number of 
sessions the new user may run at once. Specifying zero (0) lets the 
user run an unlimited number of sessions.

3 Click OK.
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To configure user-specific account settings:

1 On the Tools menu of the Server Manager window, click Configuration 
Manager. Exceed onDemand Configuration Manager opens.

2 In the User area, click Users.

3 In the Exceed onDemand Users dialog box, use the Show area to specify 
the type of users from which you want to select. The related list appears 
in the User pane.

4 Click the user whose account you want to configure, and click Select.

5 In the Exceed onDemand Server Configuration Manager dialog box, use the 
Settings area to configure the selected user’s account:

• Server Administrator Account—Enable this option to give the 
selected user administrative privileges. Administrators can create 
and edit Global profiles as well as user-specific profiles. They can 
also configure user account settings.

• Account Active—Disable this option to deactivate an account and 
prevent the selected user from starting an X session and/or 
managing his or her profiles.

• Allow Share Sessions—Enable this option if you want to let the user 
share sessions with other users.

• Allow Edit Profile Options—Enable this option if you want to let 
the user create user-defined profiles and edit them with the 
client-side Configuration Manager. For more information, see 
“Distributing Global Profiles to Users” on page 47.

• Allow Suspend Sessions—Enable this option to let the user suspend 
X sessions. For more information on Suspend/Resume 
functionality, see “Suspending and Resuming Sessions” on page 70.

• Allow Resume Sessions From Anywhere—Enable this option to let 
users resume suspended sessions from machines other than the one 
on which the session was suspended. 

• Maximum Number of Sessions—Specify the maximum number of 
sessions the user may run at once. Specifying zero (0) lets the user 
run an unlimited number of sessions.

6 Click OK.
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Managing Global Xinitrc Startup
When a user starts a client session with a configuration profile that specifies 
Run Global Xinitrc as the startup mode, Exceed onDemand Server refers to 
the administrator-managed GlobalXinitrc file. This file lets administrators 
specify which X applications should launch automatically upon connection.

                       UNIX/Linux On UNIX/Linux servers, a default file called GlobalXinitrc is created 
during installation, and the location of the file is provided so that you can 
edit it using the syntax provided in the file.

                         Windows On Windows servers, you must edit the GlobalXinitrc.cmd file using the 
syntax provided in the file.

If you distribute a configuration profile that specifies Run Global Xinitrc as 
the startup mode (or, if a user selects this startup mode for a user-specific 
configuration profile), you must edit the GlobalXinitrc file, adding the 
information required to automatically start the required X application(s).

If you do not configure the GlobalXinitrc file, Exceed onDemand Server on 
Windows does not launch applications and starts in Passive mode instead. 
Exceed onDemand Server on UNIX attempts to use the installed default file. 
If it is not successful, it starts the session in Passive mode as well.

To edit the GlobalXinitrc file:

1 On the Tools menu of the Exceed onDemand Server Manager window, 
click Configuration Manager.

2 In the Exceed onDemand Server Configuration Manager dialog box, click 
Edit Global Xinitrc in the bottom, left-hand corner.

3 The file opens in a text editor. Use the syntax described in the file to add 
commands. Click Save.

Viewing .xinitrc Logs
                        UNIX/Linux The output of commands is logged on the server. If any errors occur during 

client startup in either Run Global Xinitrc or Run Xinitrc startup mode, you 
can refer to the corresponding log file:

• Run Global .xinitrc error log—To view the log, see the 
.global_xinitrc_errors file, found in your home directory.

• Run .xinitrc log file—To view the log, see the .xinitrc_errors file, 
found in the same directory as your .xinitrc file.
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Managing Activation Keys
To add a new activation key, click Activation Keys on the Server Manager 
Tools menu. In the Activation Keys dialog box, type the new key, and click 
Add. The Total Number of Licenses value is updated to reflect the newly 
entered activation key.

Viewing the Server Log
You can view the server log file by clicking View Server Log on the Server 
manager Tools menu. The server log opens in either HTML or text format 
depending on the setting specified in the Server Settings dialog box.

Exceed onDemand UNIX Server Commands 

While you can use Exceed onDemand Server Manager to manage UNIX 
Servers, you can also use server commands to view server and user 
information. You can also perform tasks such as starting and shutting down 
the server. The administrative tools are located in the 
Exceed_onDemand_4.5/bin directory.

Starting Exceed onDemand Server
You can start the server by running the ttxpmstart utility. For more 
information, refer to the manual pages in the Exceed_onDemand_4.5/help 
directory.

Managing Activation Keys
You can change the activation key without reinstalling Exceed onDemand 
Server. Use the keymanager utility to do the following:

• add an activation key

• remove expired evaluation keys

• list installed activation keys

Saved changes take effect immediately.
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Stopping Exceed onDemand Server
You can stop the server by running the ttxpmstop utility. For more 
information, refer to the manual pages in the Exceed_onDemand_4.5/help 
directory.

Viewing Server Information
You can view information such as when the server was last started, the 
number of users currently logged into the server, and their session 
information.

To view this information, use the ttxpminfo utility. For more information, 
refer to the manual pages in the Exceed_onDemand_4.5/help directory.

Troubleshooting

Viewing the Server Log
If you need to view the sever log file, you can access it in the 
Exceed_onDemand_4.5/log directory. If you chose to generate the log file in 
text format, the file name will be ttxpm.txt. If you chose to generate the log 
file in HTML format, the file name will be ttxpm.html.
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Managing Configuration Profiles

You can access Exceed onDemand Server Configuration Manager by 
clicking Configuration Manager on the Tools menu.

As the administrator, you can use the server-side Configuration Manager to 
create, edit, and delete configuration profiles (global and user-defined). You 
can also manage the distribution of global configuration profiles to Exceed 
onDemand users.

Note: Administrative functionality is available only on the server-
side Configuration Manager. The client-side Configuration 
Manager lets users manage only their own profiles.
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Creating Global Configuration Profiles
You can create any number of global configuration profiles if you want to 
provide users with more than one standardized configuration. After you 
create these profiles you can manage their distribution. For example, you 
can create two profiles, each with different security settings, and distribute 
them to users accordingly.

To create a global configuration profile:

1 On the Server Manager Tools menu, click Configuration Manager. The 
Exceed onDemand Server Configuration Manager dialog box opens.

2 In the Global Profiles area, select an existing global profile to use as the 
basis for the new profile.

You can change the name 
of a profile at any time; 
however, the name must 
follow certain rules. For 
more information, see 
“Changing the Name of a 
Configuration Profile” on 
page 64.

3 Click Copy. A copy of the selected global profile appears in the list.

4 Rename the profile.

5 Select the newly created copy and click Options. The Exceed onDemand 
Profile Options dialog box opens.

6 Set the required options for this profile and click OK. 

7 In the Exceed onDemand Server Configuration Manager dialog box, click 
OK.

Note: 

• There must be at least one global profile at all times.

• The Global_XDMCP_Broadcast profile is installed with Exceed 
onDemand Server. 

• Two additional global profiles are installed with Exceed 
onDemand Server for UNIX only.
46



Chapter 3: Managing Exceed onDemand Server
Distributing Global Profiles to Users
The server-side Configuration Manager lets you manage user access to 
global configuration profiles. After you create a global profile, it is available 
for use by any user with an active account. The new profile cannot be edited 
by these users unless you distribute it to them directly or designate them as 
administrators.

To distribute global configuration profiles to users:

1 On the Server Manager Tools menu, click Configuration Manager. The 
Exceed onDemand Server Configuration Manager dialog box opens.

2 In the User area, click Users.

3 In the Exceed onDemand Users dialog box, use the Show area to specify 
the type of users from which you want to select. The related list of users 
appears in the User list.

4 Click the user to whom you want to distribute a global profile and click 
Select. The Users dialog box closes. The selected user’s name, account 
information, and profiles appear in the User area of the Configuration 
Manager.

5 From the Global Profiles list, select the profile you want to distribute to 
the selected user.

6 Do one of the following:

• Click the >>Copy To>> button to place an editable copy of the 
global profile in the selected user’s profile list. The original global 
profile is still available to other users.

• Click >>Move To>> to move the global profile to the selected 
user’s profile list. Doing so makes the profile available only to the 
selected user.

7 Repeat steps 2-6 for each user to whom you want to distribute global 
profiles, and then click OK in the Configuration Manager.

Note: You can move or copy the profile back to the Global Profiles 
list by selecting it in the user list and clicking <<Move To<< or 
<<Copy To<<.
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Editing Configuration Profiles
After you create a configuration profile, you can edit the profile’s option 
settings at any time with the Configuration Manager. You can also edit the 
options in existing, user-defined profiles.

To edit a configuration profile:

1 On the Server Manager Tools menu, click Configuration Manager. The 
Exceed onDemand Server Configuration Manager dialog box opens.

2 Do one of the following:

• To edit options in a global configuration profile, select the profile 
from the Global Profiles area.

• To edit options in a user-defined configuration profile, click Users. 
In the Users dialog, use the Show area to specify the type of users 
from which you want to select. Select the user from the list that 
appears in the User pane and click Select. In the Exceed onDemand 
Server Configuration Manager dialog box, select the user-defined 
profile in the Profiles area.

3 Click Options. The Exceed onDemand Profile Options dialog box opens.

4 Configure the option settings for this profile, and click OK. 

5 Click OK.

Note: The changes you make to profile option settings will not be 
implemented in client sessions that are currently running. They will 
take effect in subsequent sessions.
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Configuring Secure Sockets Layer (SSL) Options

The Secure Sockets Layer options for Exceed onDemand relate to two 
client/server network connections.   

The server and proxy ports 
are set during Server 
installation. You can 
change the port settings 
using Exceed onDemand 
Server Manager.

Configuration connections     These connections, between the Exceed 
onDemand Server server port (default 5500) and Exceed onDemand clients, 
(Server Manager or Exceed onDemand Client) transfer client startup and 
configuration information.

X Session connections     These connections, between the Exceed 
onDemand Proxy port (default 5501) and Exceed onDemand Client, 
transfer X session data.

If certificates are present, 
they will be used for any 
SSL connection.

Both types of connections can occur over Secure Sockets Layer (SSL) 
depending on how server-side and client-side settings are configured.

If you install Exceed onDemand Server with strong or weak encryption, you 
should configure the SSL settings before making the client available to users. 
The SSL settings you set on the server affect what users must do when using 
Exceed onDemand Client, and the options available to them.

Server-Side SSL Settings
To modify server-side SSL options, you must install Exceed onDemand 
Server Manager on any network PC and use it to log into the Exceed 
onDemand Server you want to configure. After you log into the server, click 
Server Settings on the Server Manager Settings menu to view the following 
SSL options in the Server Settings dialog box:

• Enable—Enables SSL for Configuration connections.

• Allow Clients To Turn Off Proxy’s SSL—Allows users to determine SSL 
usage for X session connections.

The way you configure these options has direct implications for your users. 
For more information, see the table in the next topic.

Server por t

Proxy por t

Exceed onDemand ServerExceed onDemand Client

Configuration connection

 Session connection
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Client-Side SSL Settings
There are two client-side SSL settings. Their use depends on server-side SSL 
settings.

• Use SSL—When selected, this option secures the Configuration 
connection between these clients and Exceed onDemand Server to 
protect login and startup information. It appears in the connection 
dialog boxes that open when you launch a client session (Exceed 
onDemand Server Manager or Exceed onDemand Client).

• Use SSL Between Desktop And Proxy—If this option is enabled in the 
profile selected for the Exceed onDemand Client session, then the X 
session connection between the Exceed onDemand Proxy and the 
Exceed onDemand Client desktop will be secured with SSL. This is a 
configuration profile option. It appears on the Exceed onDemand 
Specific tab of the Profile Options dialog box, which you access with the 
Configuration Manager.

The following table summarizes the server-side/client-side SSL setting 
dependencies:

Configuring the Server-Side SSL

When using ciphersuites that use the Digital Signature Standard (DSS), the 
client verifies the identity of the server before establishing an SSL-encrypted 
session. For verification, the server needs a private key file and a certificate 
file. The private key file must be named ewebpriv.pem, and the certificate 
file must be named ewebcert.pem. If you are using anonymous 
authentication, these two files are unnecessary.

If Server-side SSL settings: Then Client-side SSL settings:

Enable
Allow Clients To Turn Off 
Proxy’s SSL

Use SSL
Use SSL Between 
Desktop And Proxy

Selected Selected User must 
select

User can select

Selected Not Selected User must 
select

Forced SSL for X 
session connection

Not Selected Not Available User must not 
select

User can select
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Generating the Private Key and Certificate Files
To generate the private key and the certificate file, use the openssl utility.

                         Windows Before running the openssl utility on Windows:

1 Start a cmd window. On the Star t menu, click Run. In the Run dialog box, 
type cmd.

2 Type the following command:

PATH install location\bin\sys;%path%

where install location is the directory in which Exceed onDemand is 
installed.

                         UNIX/Linux Before running the openssl utility on UNIX/Linux:

If you are running this utility on a Solaris, AIX, Linux, or HP machine, 
ensure that the HOME environment variable is defined, and then define the 
following environment variables before running the utility.

On Solaris, AIX, or Linux, if you are using C shell, specify:

<CR> indicates that the 
given text must be entered 
as one line with a carriage 
return at the end.

setenv LD_LIBRARY_PATH install location/ 
Exceed_onDemand_4.5/bin/sys:$LD_LIBRARY_PATH <CR>

On HP, if you are using C shell, specify:

setenv SHLIB_PATH install location/ 
Exceed_onDemand_4.5/bin/sys:$SHLIB_PATH <CR>

On Linux, if you are using BASH shell, specify:

LD_LIBRARY_PATH=install location/ 
Exceed_onDemand_4.5/bin/sys:$LD_LIBRARY_PATH

export LD_LIBRARY_PATH <CR>

Note: openssl creates a file called .rnd in the current user’s 
HOME directory (UNIX), or in the root of the C: drive (Windows).

Warning!  On HP systems, you must also define the HOME 
environment variable in order to successfully run the openssl 
utility. You can set it to any directory.
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To run the openssl utility:

1 Type the following command using the appropriate slash character:

cd install location\bin

2 At the prompt, type the following command to generate random data. 
This command saves the random data to the rand.dat file. You can 
delete or refresh the rand.dat file at any time. 

openssl md5 temporary directory/* >rand.dat

where temporary directory is a directory that contains system log files 
or other temporary files. For example, you can use the /tmp directory on 
UNIX or the system temp directory on Windows.

3 Type the following command to create the dsaparams file. This file 
contains the information required for generating a private key.

openssl dsaparam -rand rand.dat -out dsaparams <number of 
bits>

4 Type the following command to generate the key file (key.pem). 

openssl gendsa -rand rand.dat -out ewebpriv.pem dsaparams

Note: 

• The <number of bits> parameter indicates the number of 
bits to generate in the private key. For US/Canadian domestic 
installations, 2048 bits is the maximum, but 1024 bits is 
common. For export (outside the US and Canada) 
installations, this number is limited to 512 bits or less. 

• This step may take some time to complete depending on the 
speed of your machine and the number of bits you have 
specified.
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5 Type the following command to generate a Certificate Signing Request 
(CSR). You require a CSR file if you want your certificate signed by a 
certificate authority (CA).

openssl req -config openssl.cnf -new -key ewebpriv.pem -out 
csr.pem

6 If you want to have your certificate signed by a CA, contact your CA for 
instructions on how to send them your CSR file.

If you do not want a CA to sign your certificate:

a) Type the following command to generate a self-signed certificate.

<CR> indicates that the 
given text must be entered 
as one line with a carriage 
return at the end.

openssl req -new -x509 -key ewebpriv.pem -out ewebcert.pem 
-config openssl.cnf <CR>

b) Move the files as follows:

Move ewebpriv.pem to install 
location/conf/home/keys/ewebpriv.pem

Move ewebcert.pem to install location/conf/home/keys/ 
ewebcert.pem

Note: This command prompts you for information, such as 
your city, state/province, department, and e-mail address. 
When prompted for the Common Name, type the fully qualified 
domain name of the host you are planning to use as your 
server, for example, eod.hcl.com. If you would like to change 
the default responses for this information, edit the 
[req_distinguished_name] section of the openssl.cnf file.
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Configuring the Client-Side SSL
When the SSL (Secure Sockets Layer) protocol is enabled, Exceed 
onDemand Server, and the proxy act as an SSL server, and Exceed 
onDemand Server Manager and Client act as SSL clients.

Exceed onDemand negotiates a number of ciphersuites. To view a list of 
available ciphersuites, consult the server log. For more information on 
viewing the server log, see “Viewing the Server Log” on page 43.

Managing Fonts

Exceed onDemand administrators can manage the availability of fonts for 
Client sessions. During an X session, Exceed onDemand Client searches the 
database of fonts and font servers that you make available.

For more information on 
the Font Editor, see Exceed 
onDemand Help.

Exceed onDemand Client users can use the Font Editor to view the list of 
available fonts and font servers. They can enable or disable a font folder or 
server and set the search priority. When Exceed onDemand Client searches 
the database for a font, it searches only user-enabled font folders or font 
servers. It searches them in the order in which they appear in the Font Editor.

On the Exceed onDemand Server, fonts are stored in one or more folders 
located in the font directory:

install directory/conf/home/font/font folder

Note: If the administrator enables SSL, then users must select 
Use SSL in the Client or Server Manager connection dialog box 
when they connect to the server or start a session. The Server 
Manager and Client will not run otherwise.
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where:

• install directory is the path created during Exceed onDemand Server 
installation.

• font folder is the name of the folder that contains:

• One or more font files—These can be .bdf or .pcf files. 

• A fonts.dir file—This file lists all font files located in the font 
folder.

• A fonts.alias file—This file lets you alias font names.

Controlling Font Availability
There are a number of ways in which administrators can determine which 
fonts are available to users. You can:

• modify the contents of existing font folders

• add new font folders/servers

• delete font folders/servers

To modify the contents of an existing font folder:

1 Copy new fonts into the font folder, or delete existing fonts from the 
folder.

The fonts.dir file located in 
the User font folder 
updates automatically.

2 Update the fonts.dir file located within the modified font folder by 
adding or removing the relevant font information.

3 If you need to give the font another name (alias), modify the 
fonts.alias file as well.

To add a new font folder:

1 Create a font folder directly in the font directory. This folder must 
contain the fonts.dir and fonts.alias files. Alternatively, you can 
create a copy of the user font folder and rename it.

2 Copy fonts into the font folder.

The fonts.dir file located in 
the User font folder 
updates automatically.

3 Update the fonts.dir file located within the modified folder by adding 
to it the required information for each font in the folder.
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4 If you need to give the font(s) another name (alias), modify the 
fonts.alias file as well.

To remove a font folder, delete it from the font directory.

To add or remove a font server:

Configuration profiles are the means by which you can make a font server 
available to your users.

When configuring a profile, the Font tab of the Profile Options dialog box lets 
you add font servers to the font database. You can either create or edit a 
configuration profile so that it specifies the font server. Users can then select 
the profile for their sessions and access the font server.

For more information on configuration profiles and adding font servers to 
the database, see Exceed onDemand Server Manager Help.

Creating and Distributing Custom Keyboards

XKeys, the Exceed onDemand keyboard editor, lets you create customized 
keyboards. The keyboard files provided with Exceed onDemand contain 
keyboard layout and symbol mappings. You can create an entire custom 
keyboard manually, but usually it is better to start with one of the existing 
keyboard files, then customize it to suit your needs. 

After you create a keyboard file, you must place it in a profile folder. The 
profile in which you place the keyboard file will determine which users have 
access to it.

Keyboard files are located on the server, in the user-defined and global 
profile folders. For example:

C:\Program files\Hummingbird\Connectivity\4.50\ExceedonDemand\
Server\conf\admin\profiles\profilename

Note: When you add a font folder, it appears in the user’s Font 
Editor, but is disabled by default. To use the fonts in the newly 
added folder, users must enable it.
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To access .kbf files in user-defined profiles, follow the users directory, 
instead of the admin directory.

To customize a keyboard file:

1 Navigate to the location of the keyboard files on the server as described 
above.

2 Use Save As to rename and save a copy of one of the original keyboard 
files (.kbf). You will use this copy to create a custom keyboard. This is a 
precaution in case you change a setting and it does not work, or you do 
not like the new settings. 

3 Navigate to the Tools folder in the installation path, and double-click 
xkeys.exe to open the keyboard editor application.

4 On the XKeys File menu, click Open and navigate to the newly created 
file.

5 After you have made your changes, save the .kbf file. For detailed 
information on customizing keyboards, see XKeys Help.

6 Copy the file to the profile folder or folders where the other .kbf files 
are stored. 

Note: This procedure assumes you have installed the editor. If you 
have not, please refer to the installation chapter for information on 
how to install this utility.

Note: You can copy the new keyboard file to a global profile to 
give all users access to it. Otherwise, you can distribute it on a 
per-user basis by placing the file in specific, user-defined profiles.
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About Exceed onDemand Sessions

Exceed onDemand offers a number of launch methods for starting a 
session. You can launch a session from the application interface, from 
Windows Explorer, from a web page, or from a command line. You can 
automate startup by creating connection documents. You can also specify 
X session behavior by creating and modifying configuration profiles.

Before you connect to a host, it is helpful to understand concepts related to 
X session configuration. For more information, see below. 

About Configuration Profiles

Configuration profiles contain settings that Exceed onDemand uses to 
configure the look and behavior of X sessions. You can create any number of 
configuration profiles to accommodate different session requirements.

Configuration profile options are grouped into 14 categories. Each group of 
options is displayed on its own tabbed page in the Profile Options dialog box.
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 The following table lists and describes profile option categories:

Input
These settings let you configure your input devices—
keyboard and mouse.

Communication
These settings let you select a startup mode for your 
session. You can also use the options on this page to 
configure all of the startup modes.               

Security    

These settings let you restrict X client access to your 
Exceed onDemand Desktop. Using the Host Access 
Control List, you can configure Exceed onDemand 
Desktop to accept only X clients from certain hosts. Using 
the Authorization File, you can configure Exceed 
onDemand Desktop to accept only X clients started from 
certain host logins/accounts.

Protocol    
These settings let you configure certain X protocol-related 
settings and determine which X protocol extensions are 
enabled or disabled.

Screen

These settings let you define various screen-related 
options. Some of the options you can configure include:

• the server visual model

• exit settings

• the window mode (single or multiple window mode)

• the window manager for use in multiple window mode

Performance

These settings let you enable or disable Backing Store 
and/or Save Unders. If Backing Store is enabled, you can 
define under what circumstances it is used. Enabling 
Backing Store or Save Unders reduces network traffic and 
improves window refresh speed at the expense of window 
drawing speed and memory.

X Selection    
This setting lets you specify the X Selection used in Exceed 
onDemand and X client copy/paste operations. You can 
also automate copy/paste functions.

Font

These settings let you customize the font database and 
specify the default text and cursor fonts. For information on 
making fonts available to users, see “Managing Fonts” on 
page 54.
62



Chapter 4: Starting Exceed onDemand Client Sessions
There are two types of configuration profiles:

• Global—These profiles are created, managed and distributed 
exclusively by administrators. Exceed onDemand is installed with one 
default global profile on Windows and three default global profiles on 
UNIX. These profiles are available to all users the first time they connect 
to a host. Administrators can create additional global profiles and make 
them available as well. All global profiles reside on the server in:

[install path\]conf\admin\profiles

• User-defined—These profiles are created and/or managed by users. 
(User-defined profiles also include profiles that administrators create 
and distribute to users.) Only administrators can access, edit, and delete 
the profiles of another user. All user profiles reside on the server in: 

[install path\]conf\users\username\profiles

Troubleshooting
These settings let you enable the logging of certain 
troubleshooting information to the log file. You can also 
enable trace from initial startup.

System 
Administration

These options enable/disable the availability of some 
product features.

Exceed onDemand 
Specific

These settings are for advanced users. The default settings 
are suitable for most situations. For detailed information, 
see Exceed onDemand Help.

Printing
These settings let you enable and disable the print feature. 
You can also manage printing behavior and specify job 
size limits.

OpenGL
These settings let you enable and disable GLX extensions 
and OpenGL features.

Video

These settings let you define various video-related options. 
Some of the options you can configure include:

• the root window size

• the screen size

• the color database

Note: Profile names are case sensitive on UNIX servers.
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When starting a Client session from the Exceed onDemand Client dialog box, 
you can view a list of the configuration profiles that are available to you and 
select the one you want Exceed on Demand to use during the session. The 
Exceed onDemand Client dialog box also lets you do the following:

Only the server-side 
Configuration Manager 
provides administrative 
functionality. For more 
information, see 
“Managing Configuration 
Profiles” on page 45.

• Access the Configuration Manager dialog box, which lets you create and 
delete configuration profiles.

• Access the Profile Options dialog box, which lets you edit the profile 
options in an existing configuration profile before selecting the profile 
for use in your X session.

Creating a User-Defined Profile
Exceed onDemand provides users with a client-side profile manager. Users 
can create their own configuration profiles as required. These profiles are 
user-specific, so they are not accessible to any other users except those who 
are designated administrators. For more information, see Exceed 
onDemand Client Help.

Changing the Name of a Configuration Profile
When naming a profile, keep the following rules in mind:

• You can use the following characters: Aa-Zz, ‘_’, ‘-’ and ‘.’.

• You cannot use names that consist solely of dots (.).

• You cannot use a name if it already exists (that is, two global profiles or 
two user-defined profiles cannot share a name, but a global profile can 
have the same name as a user-defined profile).

• You cannot use letter case to differentiate profiles on Exceed onDemand 
Servers for Windows. Only UNIX servers are case sensitive.

For more information on renaming a profile, see Exceed onDemand Client 
Help.

Editing an Existing Configuration Profile
Users can edit settings in their profiles at any time before or after starting 
the X session. In most cases, if you edit the settings after you connect, you 
must reset the server in order for the new settings to take effect. Some 
changes require you to restart Exceed onDemand Client. For more 
information, see Exceed onDemand Help.
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Connecting to a Host 

The Exceed onDemand Client dialog box appears when you start Exceed 
onDemand. Use it to start an X session. You can also access and edit 
configuration profiles before starting an X session.

If you experience problems connecting to an Exceed onDemand Server 
installed on Windows XP or Windows Server 2003, see “Troubleshooting 
Connections to Exceed onDemand Server” on page 36.
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For detailed information 
about the Exceed 
onDemand Client dialog 
box, see Client Help.

To start an Exceed onDemand session:

1 Double-click Exceed onDemand Client 4.5 on the Windows desktop, or, 
on the Windows Start menu, open the Hummingbird Exceed onDemand 
4.5 program group and click Exceed onDemand Client.

2 In the Exceed onDemand Client dialog box, fill in the login information. 
If you are connecting to a Windows host, and your computer is on a 
domain, provide the domain name and user name as follows:

domain\username

If your computer belongs to a work group, specify the group in place of 
the domain.

3 In the Profile area, select a configuration profile from the drop-down 
list. If the profile you want is not listed, click List to view the profiles 
that are available to you.

4 If necessary, configure the settings in the Connection area.

5 Click Connect. 

• If the Suspended Sessions dialog box opens, you can select a session 
to resume or start a new session. For more information, see Help.

• If the Active Sessions dialog box opens, you can select a currently 
running session to start the X client, or you can start another 
session. For more information, see Client Help.

Note: When editing configuration options, you can select one of ten 
startup modes, each of which looks and behaves differently. Some 
launch UNIX applications automatically. Others require you to select 
and login to a UNIX host before you can launch X applications.

Note: If the system administrator enables SSL on the Exceed 
onDemand Server, you must select Use SSL in the Connection area 
of the Exceed onDemand Client dialog box to connect successfully.
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Changing the Interface Language
You have the option of changing the language of the user interface before 
you connect to the host. The languages from which you can choose are 
determined during installation.

To change the language of the Exceed onDemand Client interface:

1 In the Exceed onDemand Client dialog box, open the Settings menu and 
click Language.

2 On the Language sub-menu, select the language you want Exceed 
onDemand Client to display on the interface.

3 Proceed with connecting to the host.

Automating Host Log In    

In the Exceed onDemand Client dialog box, you can create and edit 
connection documents (.eod). These files store the information you specify 
for connecting to a host. By default, the connection documents are saved in 
the Exceed onDemand Client data directory.

To create a new connection document:

1 In the Exceed onDemand Client dialog box, specify the connection 
parameters necessary to connect to the host. For more information, see 
“Connecting to a Host” on page 65.

2 On the File menu, click Save. The Save As dialog box opens. 

3 Provide a name for the connection document by editing the default file 
name, NewConnection.eod, which appears in the File Name box. 

Note: Only the Exceed onDemand Client interface reflects your 
choice of language.
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4 If necessary, change the default file location.

5 Click Save.

Editing a Connection Document
After you create a connection document (.eod), you can edit it from the 
Exceed onDemand Client dialog box at any time.

To edit a connection document:

1 In the Exceed onDemand Client dialog box, click Open on the File menu.

2 Select the connection document you want to edit, and then click Open. 
The Exceed onDemand Client dialog box displays the connection 
parameters as saved in the connection document you selected.

3 Edit the parameters you want to change.

4 On the File menu, click Save.

Launching Exceed onDemand from a Command Line

For information on creating 
connection documents, 
see “Automating Host Log 
In” on page 67.

Apart from starting an Exceed onDemand session from the desktop or from 
Windows Explorer, you can also start a session from a command line. To do 
this, you must create a connection document. These files have the extension 
.eod and contain all of the parameters you specify in the Exceed onDemand 
Client dialog box.

When you use the connection document to launch a session, Exceed 
onDemand uses the connection parameters saved in the file to start the 
session.

Note: Selecting the default location ensures that future versions of 
Exceed onDemand Client can access it.
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The command line syntax is as follows:

[path1/]ExceedonDemand.exe [path2/]connect.eod

where:

• path1 is the directory where Exceed onDemand Client is located.

• path2 is the directory where the connection document is located.

• connect.eod is the connection document which contains all 
connection parameters for starting the X session.

Launching a Session from a Web Page

For information on creating 
connection documents, 
see “Automating Host Log 
In” on page 67.

You can place a link on any web page to start an Exceed onDemand session 
according to the parameters set in a saved connection document. Use the 
following syntax in the link definition:

<a href=”connect.eod” type=application/eod>Run EOD</a>

where:

• connect.eod is the connection document you want Exceed onDemand 
to use when launching the session.

• Run EOD is the text link that appears on the web page.

Note: If a file name contains spaces, you must enclose it in 
quotation marks.
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Suspending and Resuming Sessions 

Users can suspend and resume sessions if the system administrator enables 
Suspend/Resume on the server and for the user.

This feature lets you suspend a X session instead of closing it and 
terminating all X client applications. When you reconnect to the host, 
Exceed onDemand gives you the option to resume the suspended session.

If enabled by the administrator, you can also resume the suspended session 
remotely from a different client computer.

To suspend a session, do one of the following:

For more information on 
this menu, see “Displaying 
the Exceed onDemand 
Desktop Menu” on 
page 75.

• On the Exceed onDemand Desktop menu, point to Session, and click 
Suspend.

• When closing the session, click Suspend in the confirmation dialog box. 
This confirmation dialog box appears only when Close Warning on Exit is 
selected on the Screen page of the Profile Options dialog box.

To resume a suspended X session:

1 In the Exceed onDemand Client dialog box, specify the login information 
for the host on which you suspended the session. You do not have to 
specify the same profile used in the suspended session.

2 Do one of the following:

• Click Connect. If there are no suspended sessions, Exceed 
onDemand connects to the specified host.

• Click Resume.

Note: Suspended sessions occupy resources on the server. If a 
large number of sessions are suspended, server performance can 
be affected.

Note: You can also resume a session from the connection 
document context menu.
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3 The Suspended Sessions - HostName dialog box opens and displays all of 
your suspended sessions. The icons indicate whether you can resume a 
session. Select the session you want to resume and click Resume. 

To terminate a suspended X session:

1 Open the Suspended Sessions - HostName dialog box as you would to 
resume a session.

2 Select the unwanted session and click Terminate.

Logging Off Exceed onDemand

When you are ready to end an Exceed onDemand session, exit all X clients 
and managers first. You do not have to log off Exceed onDemand to 
perform a server reset. If you want to reset the server, point to Tools on the 
Exceed onDemand Desktop menu and click X Server Reset.

To log off:

1 Exit all X clients. Click the Exit, Close, or Quit menu command for each 
X client.

2 Exit your desktop/window manager. The method you use to do this 
depends on your specific desktop/window manager. If you are running 
the Common Desktop Environment (CDE), click Exit on the desktop 
front panel.

Note: You cannot resume a session if:

• You used a different version of Exceed onDemand Client to 
start and suspend the session.

• The IP address of the suspended session does not match the 
local address, and your user account does not permit you to 
resume such sessions. See your Exceed onDemand 
administrator for more information.
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For more information on 
this menu, see “Displaying 
the Exceed onDemand 
Desktop Menu” on 
page 75.

3 Click Close on the Exceed onDemand Desktop menu.

4 If a confirmation dialog box opens, click OK. A confirmation prompt 
appears only when Close Warning on Exit is selected on the Screen page 
of the Profile Options dialog box.

Troubleshooting Exceed onDemand Client

If you experience any difficulties starting an X session, you can generate and 
view information that is useful for troubleshooting client-side issues.

Exceed onDemand Client provides two resources to help you determine the 
cause of a problem: a client log file that records the actions you perform 
using Exceed onDemand Client, and a startup progress monitor that lets 
you view information related to the Client connection to the server.

To generate troubleshooting information for Client:

1 In the Exceed onDemand Client dialog box, on the Settings menu, select 
one or both of the following options:

• Enable Logging—When this option is selected, Exceed onDemand 
records information to a client log file. This file is placed in the data 
directory, found in the program destination folder you selected 
when you installed Exceed onDemand. For example:

C:\Program Files\Hummingbird\Connectivity\4.50\
Exceed onDemand\Client\data\Exceed onDemand Client.html 

To view the remote command log file from an X session, point to 
File then View Log, and click Client Log from the Exceed onDemand 
Desktop menu.

• Show Startup Monitor—When this option is selected, a startup 
monitor appears when you connect to a host, which shows the 
progress of the client connection to the Exceed onDemand Server. 
This monitor closes upon connection.

Note: Enabling logging can increase connection time. Use this 
feature only when debugging a connection problem.
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2 Specify all the information necessary to connect to the host. For more 
information, see “Connecting to a Host” on page 65.

3 Click Connect.

About the Exceed onDemand Interface

Exceed onDemand offers two ways of viewing and working with X clients:

You can change modes on 
the Screen tab of the 
Profile Options dialog box.

Single window mode     Each X client you start is displayed in one window: 
the Exceed onDemand Desktop. 

Multiple window mode     Each X client you start is displayed in its own 
window.

Working in Single Window Mode
Exceed onDemand Desktop opens when you successfully start an Exceed 
onDemand session in single window mode. The Desktop serves as the 
primary workspace where you launch and display X clients.

Exceed onDemand Desktop consists of:

Note: At startup, Exceed onDemand Desktop appearance may 
differ depending on the startup mode selected. 

Title bar

Desktop menu

X client
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Working in Multiple Window Mode
If you enable multiple window mode, the Exceed onDemand Desktop is not 
displayed when you launch X clients. Instead, each X client you start creates 
its own new window on your display. The menus and information provided 
by the Desktop, however, are still available in multiple window mode. You 
can access them from the taskbar icon.

Viewing X Session Information
The title bar, located at the top of the Exceed onDemand Desktop, displays 
session information. In multiple window mode, you can view this 
information by placing the mouse pointer over the Exceed onDemand 
taskbar icon.

Use the title bar to view the following:

• Information you can use to determine the display specification you 
need to specify when starting an X client. The information is in the 
following form:

hostname:displayID(ipaddress:displayID)-Exceed onDemand 
Desktop-profilename-owner

For example:

eodhost:2(123.183.33.17:2)-Exceed onDemand Desktop-
GlobalProfile-psmith

• Information you can use to determine whether or not the connection is 
SSL encrypted. When encryption is on, the word secure appears in 
parentheses on the Exceed onDemand title bar.

Note: To view SSL cipher information, consult the client or proxy 
log file, which you an open from the Exceed onDemand desktop 
menu. For more information, see “Displaying the Exceed 
onDemand Desktop Menu” on page 75.
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Displaying the Exceed onDemand Desktop Menu
The Exceed onDemand Desktop menu provides server reset and trace tools. 
It also lets you perform copy and paste functions and provides access to 
Exceed onDemand options which let you configure and share your X 
session.

To display the Exceed onDemand Desktop menu, do one of the following:

• right-click the title bar

• right-click the Exceed onDemand Desktop taskbar icon

In multiple window mode, you can access this menu only by right-clicking 
the Exceed onDemand Desktop taskbar icon.

Displaying the Connection Document Context Menu
To view this menu, right click the connection document (.eod file) or the 
profile icon if you have created one on your desktop.

Note: Most menu items are not available if you are running a 
session that has been shared to you.
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Command Line Syntax for Starting X Clients

The command line syntax for starting X clients depends on:

• the X client host operating system (typically, UNIX/Linux, or VMS)

Exceed onDemand 
supports only TCP/IP.

• the transport protocol used between X client and X server

• whether you have defined certain environment variables on your 
X client host

Using Exceed onDemand Macros

If you are running in REXEC, RSH, TELNET, or SSH startup mode, you can 
specify certain display and/or login information using Exceed onDemand 
macros. You can use these macros when specifying commands for the 
following text boxes in the Exceed onDemand Star tup Modes Settings dialog 
box:

• Command box in the REXEC/RSH/TELNET/SSH tab

• Optional Reply box in the SSH/TELNET tab

• Extra SSH Options box in the SSH tab
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The following is a list of Exceed onDemand macros that can be used when 
specifying commands in REXEC, RSH, TELNET, or SSH: 

Command Line Syntax for UNIX/Linux Hosts
This section describes the commands you use when starting X clients on 
UNIX/Linux hosts.

Macro Description

@d Specifies the display specification of your Exceed onDemand 
Desktop in the form: hostname:display# or 
ipaddress:display#.

For example, ewebhost:5 or 123.45.67.89:1

@# Specifies the display number of your Exceed onDemand Desktop.

For example: If 123.45.67.89:1 is your display specification, 
then 1 is the display number.

@a Specifies the address of your Exceed onDemand Desktop.

For example, If ewbhost:5 is your display specification, then 
ewebhost is the address.

@u Specifies the value in the User ID box of the Exceed onDemand 
Startup Modes Settings dialog box, depending on the startup 
mode you are using.

@p Specifies the value in the Password box of the Exceed onDemand 
Startup Modes Settings dialog box, depending on the startup 
mode you are using.

@h Specifies value in the Host box of the Exceed onDemand Startup 
Modes Settings dialog box, depending on the startup mode you 
are using.

@@ Specifies the @ character.
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All commands consist of the following elements.

You can start X clients with the following command line syntax:

[install path/]application [parameters] -display displayspec & 

For example, you can type the following to start the xterm X client:

<CR> indicates that the 
given text must be entered 
as one line with a carriage 
return at the end.

/usr/bin/X11/xterm -sb -ls -fg blue -bg lightgrey -display 
eodhost:2 & <CR>

Element Description

path Specifies the directory where the X client you want to run is 
located.

If you have preconfigured the PATH environment variable on 
your host, then you may not need to enter the path on the 
command line. For more information, see “Setting 
Environment Variables on UNIX/Linux Hosts” on page 82.

application The executable name of the X client to run.

parameters Any command line parameters you want to specify.

displayspec The display specification of your Exceed onDemand Desktop, 
in the form: hostname:display# or ipaddress:display#.

For example, ewebhost:2 or 123.45.67.89:1. You can 
determine the hostname, display number, and IP address to 
use by using information displayed in the Exceed onDemand 
Desktop title bar.

Note: If you are using REXEC, RSH, TELNET, or SSH as your 
startup mode, you must specify @d as your command 
displayspec.

& Indicates this application should be run in the background.

Note: When starting X clients, it is a good idea to start them in 
background mode.
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If you are using REXEC, RSH, TELNET, or SSH as your startup mode, you 
can specify the following command to start the xterm X client and to 
display the user ID and host name in its title bar in the form 
userID@hostname:

/usr/bin/X11/xterm -sb -ls -fg blue -bg lightgrey -display @d 
-name “@u@@@h”& <CR>

For more information on using Exceed onDemand macros such as @d and 
@u, see “Using Exceed onDemand Macros” on page 79.

For more information on 
defining the DISPLAY and 
other environment 
variables on UNIX/Linux 
hosts, see below.

If you define the DISPLAY environment variable correctly at a command 
prompt on a particular X client host, you can omit the -display 
displayspec parameter for X clients you start from that shell with the 
following command line syntax: 

[install path/]application [parameters] &

For example:

/usr/bin/X11/xterm -sb -ls -fg blue -bg lightgrey &

Setting Environment Variables on UNIX/Linux Hosts
To simplify the startup of X clients on UNIX/Linux hosts, define the 
following environment variables on your host:

• DISPLAY

• PATH

If you would like to start X clients on a Sun host running OpenWindows, 
you may also need to specify the following environment variables on your 
host:

• OPENWINHOME

• LD_LIBRARY_PATH
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DISPLAY Environment Variable
This section describes how you define the DISPLAY environment variable 
for your current login session on a UNIX/Linux host. Many X clients use 
this variable to determine the X server display to which they should display.

The table below lists the commands you need to type at the command 
prompt for each shell to set the DISPLAY environment variable.   

Note: The syntax you use to specify the DISPLAY environment 
variable depends on whether you are using the C shell (displays 
a percentage "%" prompt, by default) or the Bourne or Korn shell 
(displays a dollar sign "$" prompt, by default). 

For Run Global Xinitrc and Run Xinitrc startup modes, on UNIX, 
the $DISPLAY variable is set by Exceed onDemand Server. On 
Windows NT, it is passed as the first argument to the script, so it 
can be accessed as %1%. For example, Xinitrc.cmd might 
contain the following line: path\Xlogo.exe -display %1%

Shell Command Example

C (%) setenv DISPLAY 
displayspec <CR>

setenv DISPLAY 
eodhost:2 <CR>

Bourne/Korn ($) DISPLAY=displayspec

export DISPLAY 

DISPLAY=eodhost:2

export DISPLAY

Note: Do not specify the DISPLAY environment variable in your 
host login startup file since your displayspec is not necessarily 
the same in each session.
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PATH, OPENWINHOME, and LD_LIBRARY_PATH 
Environment Variables
This section describes how you specify the PATH, OPENWINHOME, and 
LD_LIBRARY_PATH environment variables on UNIX/Linux hosts. 

Using the PATH environment variable, you can add directories to your path 
specification. If you enter a command without specifying its full path, the 
shell searches each directory listed in the PATH environment variable for 
the application executable and executes the first one it finds. Consider 
specifying these environment variables in your host login startup file, so 
they are set each time you log in to the host.

The table below lists the commands required by each shell to set the PATH 
environment variable.  

where path is a directory that you want to include on your host path. 
Separate multiple paths with colons (:).

Note: The OPENWINHOME and LD_LIBRARY_PATH environment 
variables are needed only for Sun OpenWindows hosts.

Shell Command Example

C (%) setenv PATH path:path:path setenv PATH

/usr/bin/X11:/usr/bin/
jsmith <CR>

Bourne/Korn ($) PATH=path:path:path

export PATH

PATH=/usr/bin/X11:/usr
/bin/jsmith <CR>

export PATH
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The table below lists the commands required by each shell to set the 
OPENWINHOME and LD_LIBRARY_PATH environment variables.

where usr is the directory on the host where the X Window system files 
reside.

To determine which environment variables are defined and their values, 
type the following commands at the shell prompt:

To determine if a specific environment variable is defined and to determine 
its value, type the following command at the shell prompt:

echo $variablename

where variablename is the name of the environment variable.

If the environment variable is not defined or is incorrectly defined, define it 
properly in your host login startup file.

Shell Example

C(%) setenv OPENWINHOME /usr/openwin

setenv LD_LIBRARY_PATH /usr/openwin/lib

Bourne/Korn($) OPENWINHOME=/usr/openwin

LD_LIBRARY_PATH=/usr/openwin/lib

export OPENWINHOME LD_LIBRARY_PATH

Shell Commands

C(%) setenv

printenv

Bourne/Korn($) env

export

printenv
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To define the environment variable in your host startup login file:

1 Open your host startup login file in a text editor. If you are using the 
C shell, the .cshrc file in your home directory is the login startup file. If 
you are using the Bourne or Korn shell, the .profile file in your home 
directory is the login startup file.

2 Find the environment variable in the file and enter the correct 
command as specified in the appropriate tables that precede this 
procedure.

3 Save the file and exit the text editor.

The next time you start a shell session, your environment variable will be set 
properly. To verify this, start a new login/shell session and use the necessary 
commands described to determine the current value of these environment 
variables.

Command Line Syntax for VMS Hosts
This section describes the command line syntax you use to start X clients on 
VMS hosts. 

If your VMS system supports REXEC, RSH, TELNET, or SSH and is 
running version 5.0 or higher of the PCX$SERVER command processor, 
you can specify a command with the following syntax to start an X client 
using the REXEC, RSH, TELNET, or SSH startup modes:

@@sys$system:pcx$server 4,@#,0,tcpip,@a application

where application is the command line required to run the application.

For more information on 
Exceed onDemand 
macros, see “Using 
Exceed onDemand 
Macros” on page 79.

You must use these the @# and @a macros since the display number and 
ipaddress are not necessarily the same for each session. For example, to start 
the xterm X client:

@@sys$system:pcx$server 4,@#,0,tcpip,@a DECW$TERMINAL

Note:  If the environment variable is not defined, specify the 
environment variable by typing the command at the end of the 
file.
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If you use the Passive startup mode, and you want to specify the X display 
server to which the X clients should display, you need to define the 
DISPLAY environment variable prior to starting any X clients. You do not 
need to define the DISPLAY environment variable when using REXEC, 
RSH, TELNET, or SSH startup modes as PCX$SERVER sets DISPLAY for 
you. Use the following command line to set the DISPLAY environment 
variable:

<CR> indicates that the 
given text must be entered 
as one line with a carriage 
return at the end.

set display/create/node=ipaddress/transport=tcpip/ 
server=display# <CR>

You can determine the ipaddress and display number from the information 
displayed on the Exceed onDemand title bar. 

For example:

set display/create/node=123.183.33.17/transport=tcpip/server=2

Do not put spaces before or after the equal (=) sign.

For more information, see 
“Viewing X Session 
Information” on page 74.

If you are using the Wollongong VMS TPC/IP transport, replace tcpip with 
wintcp.

After the DISPLAY environment variable is set correctly for a login session, 
you can start X clients from that session using the following command line 
syntax:

run sys$system:decw$application

For example:

run sys$system:decw$clock

Note:  Do not specify the DISPLAY environment variable in your 
host login startup file since the ipaddress and display number are 
not necessarily the same in each session.
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General Accessibility

Hummingbird products are accessible to all users. Wherever possible, our 
software was developed using Microsoft Windows interface standards and 
contains a comprehensive set of accessibility features.

Keyboard Shortcuts     Keyboard shortcuts appear as underlined letters in 
the names of most UI items. If this is not the case, press Alt to reveal them. 
You can use these shortcuts instead of a mouse to navigate the user interface 
and access commands. For example, to open any menu, press Alt and then 
press the key that corresponds with the underlined letter in the menu name. 
In most cases, Alt+F opens the File menu.

Once you have opened a menu, you can access a menu command in the 
following ways:

• Press the underlined letter in the menu command name.

• Use the arrow keys to select the required command, and press enter.

• If one is provided, type the key sequence to the right of the command. 
You can use this key sequence at any time.

Directional Arrows     Use the directional arrows on the keyboard to 
navigate through menu items or to scroll vertically and horizontally. You 
can also use the directional arrows to navigate through multiple options. 
For example, if you have a series of radio buttons, you can use the arrow 
keys to navigate the possible selections.

Tab Key Sequence     To navigate through a dialog box, press the Tab key. 
Selected items appear with a dotted border. You can also press Shift+Tab to 
go back to a previous selection within the dialog box. 

Spacebar     Press the Spacebar to toggle check boxes on and off or to select 
buttons in a dialog box.

Esc     Press the Esc key to close a dialog box without implementing any new 
settings.
91



Exceed onDemand Administrator’s Guide
Enter     Press the Enter key to select the highlighted item or to close a dialog 
box with the new settings. You can also press the Enter key to close all About 
boxes.

ToolTips     ToolTips appear for all functional icons. This feature lets users 
use Screen Reviewers to make interface information available through 
synthesized speech or through a refreshable Braille display.

Microsoft Accessibility Options
Microsoft Windows environments contain accessibility options that let you 
change how you interact with the software. This feature can add sound, 
increase the magnification, and create sticky keys.

To configure the Accessibility options:

1 In Control Panel, double-click Accessibility Options. 

2 In the Accessibility Options dialog box, use the tabbed pages to 
configure the option settings.

3 Click OK.
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Technical Support

You can contact the Hummingbird Technical Support department Monday 
to Friday between 8:00 a.m. and 8:00 p.m. Eastern Time.  

Hummingbird Ltd.
1 Sparks Avenue, North York, Ontario, Canada M2H 2W1

Canada and the USA International

Technical Support: 1-800-486-0095 +1-416-496-2200

General Enquiry: 1-877-FLY-HUMM +1-416-496-2200

Main: +1-416-496-2200

Fax: +1-416-496-2207

E-mail: support@hummingbird.com

FTP: ftp.hummingbird.com

Online Request Form: www.hummingbird.com/support/nc/request.html

Web Site: www.hummingbird.com/about/contact.html
93

mailto:support@hummingbird.com
ftp://ftp.hummingbird.com
http://www.hummingbird.com/support/nc/request.html
http://www.hummingbird.com/about/contact.html




Index
Symbols
&, command description............................... 81

A
accessibility features....................................... 91
accounts, user ................................................ 39

migrating .................................................. 5
Activation Key utility.................................9, 43
activation keys

managing................................................ 43
utility for Server on UNIX .................9, 43

active sessions
reusing .................................................... 66

administrative components........................... 17
administrator designation ............................. 39
application, command description ............... 81
architecture ...................................................... 3
automating

X application startup.............................. 42

B
Backing Store ................................................. 62

C
certificates for SSL ......................................... 51
ciphersuites .................................................... 54
Client

deploying over the web .......................... 23
installation requirements ......................... 7
installing ................................................. 19
uninstalling............................................. 20

color database ..........................................62, 63
command line syntax

for starting Exceed onDemand .............. 69
for starting X clients ............................... 79
for UNIX/Linux hosts ............................ 80
for VMS hosts......................................... 86

Common Desktop Environment (CDE) ...... 71
configuration connections.......................38, 49
Configuration Manager ................................. 34

managing profiles ................................... 45
new user settings .................................... 39
per-user settings ..................................... 41

configuration profiles .................................... 61
allowing users to edit.............................. 39
creating ................................................... 64
distributing ............................................. 47
editing...............................................48, 64
managing ................................................ 45
migrating ..................................................5
renaming ................................................ 64
types defined........................................... 61

configuring
accounts for new users ........................... 39
accounts per user.................................... 39
Global Xinitrc startup ............................ 42
keyboard ...........................................56, 62
X protocol............................................... 62

connecting
with Client .............................................. 65
with Server Manager .............................. 35



Exceed onDemand Administrator’s Guide
connection documents (.eod)................. 67, 69
creating ...................................................67
displaying context menu for...................75
editing .....................................................68

connection types ............................................49
Configuration .........................................39
X Session.................................................39

context menu for connection documents .....75
copy and paste

X selection options .................................62
creating

connection documents ...........................67
global profiles .........................................46
user-defined profiles...............................64

cursor fonts ....................................................62
customizing font database .............................62

D
default text fonts.............................................62
deleting

projects....................................................25
Deployment Packager, packages

creating ...................................................24
deployment packages

new..........................................................25
saving as a project ...................................24
updating..................................................30

Deployment Tools ...........................................5
installation requirements..........................7
installing..................................................17

Deployment Wizard.......................................23
default settings ........................................25

desktop. See Exceed onDemand Desktop.
directory variables ..........................................26
disconnecting

Server Manager sessions .........................35
DISPLAY ........................................................82
display ID

setting......................................................37
UNIX Server .............................................9

display, command description.......................81

displaying
connection document context menu .... 75
Exceed onDemand desktop menu......... 75

E
editing

configuration profiles.......................48, 64
connection documents .......................... 68
GlobalXinitrc file.................................... 42

elpr. See Print Utility.
encryption...................................................... 49
environment variables ................................... 79

and xinitrc.cmd...................................... 83
defining .................................................. 86
on UNIX/Linux hosts ............................ 82

.eod files. See connection documents (.eod).
Exceed onDemand .......................................... 3

administrating ........................................ 33
architecture .............................................. 3
Desktop menu........................................ 75
Desktop title bar..................................... 74
security features........................................ 4
system requirements ................................ 7

Exceed onDemand Client. See Client.
Exceed onDemand Desktop.......................... 73

menu ...................................................... 75
title bar ................................................... 74

Exceed onDemand Options
Exceed onDemand Specific ................... 63
Font ........................................................ 62
Input....................................................... 62
OpenGL.................................................. 63
Performance........................................... 62
Printing .................................................. 63
Protocol .................................................. 62
Screen ..................................................... 62
Security................................................... 62
Selection ................................................. 62
System Administration .......................... 63
Troubleshooting..................................... 63
Video ...................................................... 63

Exceed onDemand Print Utility. See Print 
Utility.
96



Index
Exceed onDemand Server. See Server.
Exposé Online.................................................. 6

F
feature tree ...............................................12, 14
features

controlling availability ........................... 63
file location variables ..................................... 26
file types

GlobalXinitrc.......................................... 42
key.pem .................................................. 52
rand.dat .................................................. 52

Font options .................................................. 62
fonts ............................................................... 54

adding..................................................... 54
adding font servers ................................. 54
aliasing names ........................................ 54

G
global profiles

distributing............................................. 47
GlobalXinitrc file

editing..................................................... 42
migrating .................................................. 5

H
Host Access Control List ............................... 62
.html file......................................................... 29
HTML page

title.......................................................... 29
URL ........................................................ 28

Hummingbird accessibility ........................... 91
Hummingbird Component Deployment

uninstalling............................................. 20
Hummingbird Information Resources

Technical Support.................................. 93

I
index page

creating................................................... 29
title.......................................................... 29

Index Page Wizard .........................................28
scenario...................................................28

information resources, Hummingbird
Technical Support ..................................93

installation
feature options (install state)........... 12, 14
overview....................................................5
requirements.............................................7
silent........................................................15
updating..................................................16
upgrading..................................................5

installing
administrative components....................17
Client ......................................................19
Client over the web.................................23
Deployment Tools ..................................17
Exceed onDemand Print Utility.............17
keyboard editor.......................................17
Server Manager.......................................17
Server on UNIX........................................8
Server on Windows ................................10
silent........................................................15

K
keyboard

shortcuts .................................................91
keyboard configuration..................................62

creating custom keyboards.....................56
keyboard editor ......................................... 5, 19

installing .................................................17
key.pem ..........................................................52

L
LD_LIBRARY_PATH....................................82
licenses............................................................43
log files

client log..................................................72
server log.................................................38
viewing server log ...................................43

logging off Exceed onDemand.......................71
logging troubleshooting information ............72
97



Exceed onDemand Administrator’s Guide
M
Master Setup ..................................................11
menus

connection document context menu.....75
Exceed onDemand desktop menu .........75

migration, from another version .....................5
Msetup.exe .............................................. 14, 15

personal installation ...............................11
Msiexec.exe ....................................................16
multiple window mode..................... 62, 73, 74

viewing menus ........................................74
viewing session information...................74
viewing the Desktop menu.....................75

N
network

reducing traffic........................................62
network connections......................................49

for configuration.....................................49
ports ........................................................38
X session (thin X protocol) ....................49

new user account settings ..............................39

O
OpenGL options ............................................63
opening an existing project ............................25
OPENWINHOME.........................................82
Options. See Exceed onDemand Options.

P
package settings

saving ......................................................24
Package Update Wizard.................................30
packages, deployment

deleting ...................................................25
new..........................................................25
updating..................................................30

parameters, command description................81
Passive startup mode......................................62
PATH .............................................................82
path, command description...........................81
Performance options......................................62

per-user account settings............................... 39
port number

UNIX Server............................................. 9
Windows Server ..................................... 13

ports
configuring ............................................. 37
proxy ...................................................... 49
server ...................................................... 49

Print Utility................................................5, 17
installing ................................................. 17

printing
options.................................................... 63
Print Utility ........................................5, 17
Server Manager information.................. 34

Printing options............................................. 63
private keys for SSL........................................ 51
product features

feature tree, viewing .........................12, 14
profiles. See configuration profiles.
program maintenance ................................... 14

migration.................................................. 5
modifying install state ............................ 14
removing Server on Windows platform 15
repairing ................................................. 14

projects, deployment
creating................................................... 24
deleting ................................................... 25
opening................................................... 25
saving...................................................... 24

Protocol options ............................................ 62
proxy port ................................................38, 49

R
rand.dat.......................................................... 52
refreshing

information in Server Manager ............. 34
registering the product .................................... 6
renaming configuration profiles ................... 64
resources, Hummingbird information

Technical Support.................................. 93
restarting the server ....................................... 37
restricting access to some options ................. 62
resuming sessions. See suspend/resume.
98



Index
reusing active sessions ................................... 66
REXEC startup mode .................................... 62
root window size......................................62, 63
RSH startup mode ......................................... 62

S
Save Unders ................................................... 62
saving

connection documents .......................... 67
deployment projects............................... 24
information in Server manager.............. 34

Screen options .........................................62, 63
screen size ................................................62, 63
scroll bars .................................................62, 63
Secure Sockets Layer (SSL)........................4, 49

Client ciphersuites.................................. 54
client-side settings .................................. 50
creating keys and certificates.................. 51
enabling for clients ................................. 39
keys, migrating ......................................... 5
Server\Client setting dependencies........ 50
server-side settings ...........................49, 50
setting options on Server ....................... 37
troubleshooting...................................... 36

security.....................................................49, 62
Server

generating a log ...................................... 38
management tool ........................ 5, 17, 33
proxy port number................................. 38
restarting ................................................ 37
server port number ................................ 38
See also Server (on Windows), or Server 

(on UNIX).

Server (on UNIX)
changing the activation key ....................43
command utilities...................................43
controlling status ....................................43
display ID..................................................9
installation requirements..........................7
installing ...................................................8
management tool....................................33
port number .............................................9
SSL options .............................................50
viewing information ...............................44
viewing Server information ....................43
viewing the log........................................43
xinitrc logs ..............................................42

Server (on Windows)
installation requirements..........................7
installing .................................................10
management tool....................................33
port number ...........................................13
SSL options .............................................50
viewing the log........................................43

Server Manager ..............................................33
adding activation keys ............................43
changing server port numbers................38
connecting to Server ...............................35
disconnecting..........................................35
installation requirements..........................7
installing ............................................ 5, 17
managing configuration profiles ............45
managing user accounts .........................39
refreshing displayed information ...........34
saving displayed information .................34
setting display ID....................................37
SSL options .............................................39
viewing the server log .............................43

server port ............................................... 38, 49
sharing

enabling for users ...................................39
shortcuts

Keyboard.................................................91
silent installation ............................................15

of Client ..................................................15
of Server ..................................................15
99



Exceed onDemand Administrator’s Guide
single window mode ......................................73
SSH

client........................................................38
server-side setting ...................................38

SSL. See Secure Sockets Layer (SSL).
starting

an Exceed onDemand session ......... 61, 65
an X session ............................................65
from a command line .............................68
from a web page............................... 68, 69
from Windows Explorer.........................68
X sessions automatically .........................67

starting X clients
command line syntax................. 43, 44, 79
command line variables..........................79
syntax for UNIX/Linux hosts .................80
UNIX/Linux environment variables ......82

startup modes............................................ 3, 62
REXEC....................................................62
RSH.........................................................62
Run Global Xinitrc .......................... 42, 62
Run Xinitrc .............................................62
SSH .........................................................62
Telnet ......................................................62

startup progress indicator ..............................72
stopping/starting Server on UNIX.................43
suspend/resume ...................................... 66, 70

enabling for users............................. 37, 39
terminating a suspended session............70

system requirements
Client ........................................................7
Deployment Tools ....................................7
Server ........................................................7
Server Manager.........................................7

T
Technical Support..........................................93
Thin X Protocol (TXP) ....................................3
title bar information.......................................74

troubleshooting
connecting to a host ............................... 36
diagnostic tools ...................................... 72
options.................................................... 63
the server ................................................ 44

U
uninstalling .................................................... 19

Client ...................................................... 20
Component Deployment....................... 20
Deployment Tools ................................. 19
Exceed onDemand Client ...................... 20
Exceed onDemand Print Utility ............ 19
Server Manager ...................................... 19
Server on UNIX platform ...................... 10
Server on Windows platform................. 15

updates for products...................................... 16
updating

deployment packages ............................. 30
Exceed onDemand................................... 5

URL, deployment
distributing............................................. 28

user accounts
activating ................................................ 39
migrating .................................................. 5
settings.................................................... 39

V
variables

directory ................................................. 26
environment.....................................79, 84

Video options ................................................ 63
viewing

server information ...........................17, 44
the server log .......................................... 44

VMS host command line syntax ................... 86
100



Index
W
web browser

title of index page ................................... 29
web page

file name ................................................. 29
linking .................................................... 68

web server
copy files to............................................. 27

window mode ................................................ 73
multiple .................................................. 73
single....................................................... 73

window refresh speed .................................... 62

X
X protocol ......................................................62
X server visual model .............................. 62, 63
X sessions

automating startup .................................67
connection types.....................................49
starting ............................................. 61, 65
suspending/resuming .............................70

XDMCP startup modes
Broadcast ................................................62
Indirect ...................................................62
Query ......................................................62

xinitrc logs for UNIX Server ..........................42
xinitrc.cmd

DISPLAY variable...................................83
XKeys. See keyboard editor.
101



Notes



Notes



Notes


	Contents
	Chapter 1: Installing Exceed onDemand
	About Exceed onDemand
	Overview of Installation
	Preserving Files When Upgrading
	Registering

	System Requirements
	Exceed onDemand Server
	Exceed onDemand Client and Components

	Installing Exceed onDemand Server on a UNIX Platform
	Uninstalling Exceed onDemand Server on UNIX

	Installing Exceed onDemand Server and Other Components on Windows
	Program Maintenance
	Silent Installation
	Updating the Product

	About Server Components
	Installing the Components on Windows
	Installing Exceed onDemand Print Utility
	Uninstalling Components

	Installing Exceed onDemand Client
	Uninstalling Exceed onDemand Client


	Chapter 2: Deploying Exceed onDemand Client
	About Exceed onDemand Deployment Tools
	About Exceed onDemand Deployment Wizard
	Overview of the Deployment Process
	Creating a Deployment Package
	Configuring Deployment Wizard Settings
	Exceed onDemand Directory Variables
	Making the Package Available

	About Exceed onDemand Index Page Wizard
	Creating an Index Page

	About Exceed onDemand Package Update Wizard
	Updating Exceed onDemand Client for Deployment


	Chapter 3: Managing Exceed onDemand Server
	About Exceed onDemand Administration
	About Exceed onDemand Server Manager
	Connecting to the Server
	Configuring Server Settings
	Managing User Accounts
	Managing Global Xinitrc Startup
	Managing Activation Keys
	Viewing the Server Log

	Exceed onDemand UNIX Server Commands
	Starting Exceed onDemand Server
	Managing Activation Keys
	Stopping Exceed onDemand Server
	Viewing Server Information
	Troubleshooting

	Managing Configuration Profiles
	Creating Global Configuration Profiles
	Distributing Global Profiles to Users
	Editing Configuration Profiles

	Configuring Secure Sockets Layer (SSL) Options
	Configuring the Server-Side SSL
	Configuring the Client-Side SSL

	Managing Fonts
	Controlling Font Availability

	Creating and Distributing Custom Keyboards

	Chapter 4: Starting Exceed onDemand Client Sessions
	About Configuration Profiles
	Creating a User-Defined Profile
	Editing an Existing Configuration Profile

	Connecting to a Host
	Changing the Interface Language

	Automating Host Log In
	Editing a Connection Document

	Launching Exceed onDemand from a Command Line
	Launching a Session from a Web Page
	Suspending and Resuming Sessions
	Logging Off Exceed onDemand
	Troubleshooting Exceed onDemand Client
	About the Exceed onDemand Interface
	Viewing X Session Information
	Displaying the Exceed onDemand Desktop Menu
	Displaying the Connection Document Context Menu


	Appendix A: Command Line Syntax
	Using Exceed onDemand Macros
	Command Line Syntax for UNIX/Linux Hosts
	Setting Environment Variables on UNIX/Linux Hosts
	Command Line Syntax for VMS Hosts

	Appendix B: Accessibility and Technical Support
	General Accessibility
	Microsoft Accessibility Options

	Technical Support

	Index

